
 

 

 

 

 

 

 

 

Stellar Toolkit for File Repair 

Version 2.0.0.0 

User Guide 

 

 

 

 

 



 

 

Overview 

Stellar Toolkit for File Repair is collection of following software. 

1. Stellar Phoenix Word Repair 

2. Stellar Repair for Excel 

3. Stellar Repair for PowerPoint 

4. Stellar Repair for PDF 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Installation Procedure 

Before installing the software, ensure that your computer meets the minimum system requirements. 

Minimum System Requirements: 

• Processor: Pentium Class 

• Operating System: Windows 10 / 8.1 / 8 / 7 / Vista 

• Memory: 2 GB minimum (4 GB recommended)  

• Hard Disk: 250 MB of free space 

To install the software: 

1. Double-click StellarToolkitforFileRepair.exe. Setup dialog box is displayed. 

2. Click Next to continue. License Agreement dialog box is displayed. 

3. Select I accept the Agreement option. Click Next. 

4. Specify the location where the installation files are to be stored. Click Next. 

5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click 
Browse to select a different location. Click Next. 

6. In the Select Additional Tasks dialog box, select check boxes as per your choice. Click Next. 

7. Review your selections. Click Back if you want to make any change. Click Install to start 
installation. The Installing window shows the installation process. 

8. After completion of the process, Completing the Stellar Toolkit for File Repair Setup Wizard 
window opens. Click Finish. 

Note: Clear Launch Stellar Toolkit for File Repair check box before clicking Finish to prevent the 

software from launching. 

  



User Interface 

 

 

 

 

 

 

 

 

 

 

 

 



Ordering the Software 

Click  https://www.stellarinfo.com/file-repair/file-repair-toolkit.php to know more about Stellar 

Toolkit for File Repair. 

To purchase the software online, please visit https://www.stellarinfo.com/file-repair/file-repair-

software/buy-now.php. 

Alternatively, click on Buy Online icon in Buy Online Ribbon to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a key will be sent to you through e-mail, which would be required to 

activate the software. 

  

  

https://www.stellarinfo.com/file-repair/file-repair-toolkit.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


Activating the Software 

The demo version is for evaluation purpose only. You need to activate the software to use its full 

functionality. Use the Activation Key received via email after purchasing the software to activate it. 

To activate the software: 

1. Run the demo version of the software. 

2. Click the Activation button. Activation window is displayed as shown below: 

  

 

  

3. If you don't have the activation key, click Get it now button in the window to purchase the 

software. 

4. Once the order is confirmed, an Activation Key is sent to the email that you have provided while 

purchasing the software. 

5. Paste or type the Activation Key (received through email after purchasing the product) and click 

Activate button (Please ensure an active Internet connection). 

6. Stellar Repair for Excel automatically communicates with the license server to verify the 

entered key. If the entered key is valid, activation is completed successfully. 

7. 'Activation Completed Successfully' message is displayed. Click OK. 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 

You can either Call Us or Go Online to our support section http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/file-repair/file-repair-

software/buy-now.php  
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User Guide 

Version 5.5.0.0 



 

 

Overview 

'Stellar Phoenix Word Repair' is designed to repair corrupted 'Microsoft Word' (.doc and/or .docx) files. 

This software scans selected 'Word' documents and uses an advanced algorithm to restore 'Word' files 

back to their original state. The repaired files can either be saved at their original location on the hard disk, 

or at any user-specified location. 

The software gives three types of repair options to users - 'Save', 'Advance Repair', and 'Raw Preview'. 

The last two options are available only for .doc file while the first one can be applied on both .doc and .docx 

files. 

User can preview 'Word' files in three different modes - 'Full document', 'Filtered Text', and 'Raw Text'. 

'Full document' view displays scanned file exactly as a 'Word' file opened in 'Microsoft Word'. 'Filtered text' 

shows only the text of the 'Word' file without formatting and other attributes of the content. 'Raw Text' shows 

machine-readable format of the file. 

User can search for 'Word' files in folders and drives. You can save individual or all files. In addition, you 

can save files at the original location or at a location of your preference. 

What's New 

• New and Enhanced GUI. 

Key Features of 'Stellar Phoenix Word Repair'  

• Provides options of 'Save', 'Advance Repair', and 'Raw Preview'. 

• Preview of files in 'Full document', 'Filtered Text', and 'Raw Text' formats. 

• Searches for 'Word' documents (.doc, .docx) in a folder or a drive. 

• Repairs text, font (color, size, name), hyperlinks and preserves formatting of original document. 

• Repairs 'Header/Footer'. 

• Repairs 'Bookmarks'. 

• Repairs 'Charts'. 

• Repairs 'Comments'. 

• Repairs 'Footnote/Endnote'. 

• Repairs 'Auto shapes'. 

• Repairs 'Pictures'. 

• Repairs 'Fields'. 

• Repairs 'Controls'. 



• Repairs 'Caption'. 

• Generates 'Log report' for further analysis. 

• Repairs online videos inserted in Word 2013 files. 

• Repairs online pictures inserted in Word 2013 files. 

• Supports MS Word 2013, 2010, 2007, 2003 and XP (2002). 

• Compatible with Windows 8.1 / 8 / 7 / Vista / XP. 



 

 

  

 

Features 

'Stellar Phoenix Word Repair' has many features that make it unique among other products. It has the 

ability to perform whole drive scan to search all the 'Word' files and to repair corrupt files without any kind 

of modification to original files. 

The main features can be listed as follows: 

• Search for 'Word' Files: 'Stellar Phoenix Word Repair' gives a unique user-friendly option to 

search for 'MS Word' files with .doc and .docx extension if the exact location of file is unknown or 

forgotten. You can search your file in whole hard drive, volume or a folder. Search result shows the 

name, size, creation date and modification date of the files. These options help in selecting and 

identifying the required 'Word' file for repair. 

• Preview of Files: 'Stellar Phoenix Word Repair' gives an option to preview corrupted 'Word' file 

after scanning. User can preview in three different formats - Full document, Filtered text and Raw 

text. Preview option enables user to take decision like whether to further examine the file or simply 

repair the file. 

• Advance Repair: The software gives user the option to go for 'Advance Repair' if the corrupted file 

has not been repaired or the repaired file is not satisfactory. This option is available for .doc files 

only. 

• Raw Preview: If user is not satisfied with the result even after doing 'Advance Repair', he can go 

for 'Raw Preview'. Like 'Advance Repair', this option too is available for .doc files only. It previews 

everything that is found in the file in the format of 'Raw Text' (machine readable format). 

• Generation of 'Log Report': 'Log report' contains details of the repair process such as beginning 

of the process, end of the process, name of the corrupted 'Word' file and so on. 

 

 

 

 

 

  

 



Installation Procedure 

Before installing the software, ensure that your computer meets the minimum system requirements. 

Minimum System Requirements 

Processor : Pentium Class 

Operating System: Windows 8.1 / 8 / 7 / Vista / XP 

Memory : 1 GB recommended 

Hard Disk : 50 MB of free space 

MS Office: 2013 / 2010 / 2007 / 2003 / 2002 (XP) 

To install the software: 

1. Double-click StellarToolkitforFileRepair.exe executable file to start installation. Setup - Stellar 

Toolkit for File Repair dialog box is displayed. 

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

6. Select check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

7. Review your selections. Click Back if you want to change them. Click Install to start installation. 

The Installing window shows the installation process. 

8. On completion of the installation process, Completing the Stellar Toolkit for File Repair Setup 

Wizard window is displayed. Click Finish. 

 You can clear 'Launch Stellar Toolkit for File Repair' check box to stop the automatic launch of the 

software. 

  



 

 

Launching the Software 

  

To launch Stellar Phoenix Word Repair in Windows 8: 

• Click Stellar Toolkit for File Repair tile on the home screen and then click Repair Document. Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair Document. 

  

To launch Stellar Phoenix Word Repair in Windows 7: 

• Click Start -> Programs -> Stellar Toolkit for File Repair -> Repair Document. Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair Document. Or, 

• Click Stellar Toolkit for File Repair icon in Quick Launch and then click Repair Document. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



User Interface 

'Stellar Phoenix Word Repair' has a very simple and user friendly 'Graphical User Interface' (GUI) as 

shown below: 

  

 

  

With 'Menus' and 'Buttons' on the user interface, you can access its various features quite easily. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 



 

 

Menus 

The menus of 'Stellar Toolkit for File Repair' software are described below: 

File Menu 

  

 

Add File 

Use this option to add 'Word' files to the software 

for repair. 

Remove File 

Use this option to remove selected files from the 

tree view. 

Save 

Use this option to start the repair process. 

Advance  Repair 

Use this option to repair severely corrupted files. 

Stop 

Use this option to abort scanning or repair 

process. 

Exit 

Use this option to quit the application. 

Status Bar and Message Log 

Check/Uncheck these boxes to view or hide the 

Status Bar and Message Log. 

   

   

Tools Menu 

  
Save Log 

Use this option to save the log report. 



 

Clear Log 

Use this option to clear the log report contents. 

Raw Preview 

Use this option to preview .doc files in 'Raw Text' 

format. 

Activate 

Use this option to activate the software. 

Updates 

Use this option to check for both, latest minor and 

latest major versions available online. 

  

Help Menu 

  

 

Buy 

Use this option to purchase the software. 

Support Section 

Use this option to view the support page of 

stellarinfo.com 

Knowledgebase 

Use this option to visit Knowledgebase 

articles of stellarinfo.com 

Submit Enquiry 

Use this option to Submit enquiry to 

stellarinfo.com 

About 

https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 

 

Use this option to read information about the 

software. 

Help 

Use this option to open help manual for the 

software. 

  



Buttons 

'Stellar Phoenix Word Repair' software has the following buttons: 

  

  

 

  

Click this button to select the file which you want to repair. 

  

 

  

  

Click this button to select the location in which your files are located. 

  

 

  

  

Click this button to search for files located in your drives. 

  

 
  

  

Click this button to clear the list of files found in the system. 

  

 

  

  

Click this button to open the help manual for the software. 

  

     

  

  

Click this button to register the software. 

  

 

  

  

Click this button to stop an ongoing repairing process. 

  

 

  

  

Click this button to scan the files which you want to repair. 

  



 

 

How to Order? 

'Stellar Toolkit for File Repair' can be purchased by making payments online using a credit card. Please 

visit, https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php  for more information and to 

place an order. 

You can find various offers, available at the site to buy the software. For evaluation, you can also download 

the latest demo version of the software from the web site. 

If you have demo version of the software installed, click 'Purchase'  icon on the main user interface to 

open the buy page of the software. 

Once the payment is complete, an activation serial number along with activation details is sent via e-mail. 
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How to Activate? 

The demo version is for evaluation purpose only. You need to activate the software to use it's full 

functionality. Use the Activation Key received via e-mail after purchasing the software to activate it. 

To activate the software: 

1. Run the demo version of the software. 

2. From the Tools Menu, click the Activation button. Activation window is displayed as shown 

below: 

 

  

3. If you don't have the activation key, click Get it now button in the window to purchase the software. 

Once the order is confirmed, an Activation Key is sent to the e-mail that you have provided while 

purchasing the software. 

4. Paste or type the Activation Key (received through e-mail after purchasing the product) and click 

Activate button (Please ensure an active Internet connection). 

 

5. The software automatically communicates with the license server to verify the entered key. If the 

entered key is valid, activation is completed successfully. 

6. 'Activation Completed Successfully' message is displayed. Click OK. 

  



 

 

 

How to Update? 

Stellar releases periodical software updates for Stellar Toolkit for File Repair software. You can update 

the software to keep it up-to-date. These updates can add new functionality, feature, service, or any other 

information that can improve the software. Update option of the application is capable of checking for latest 

updates. It checks for both latest minor and major versions available online. While updating the software, 

it’s recommended to close all the running programs.  

To update the application, follow these steps: 

1. Run activated version of Stellar Toolkit for File Repair software. 

2. Click Repair Document button. 

3. Select 'Updates'   option in 'Tools' menu. 'Update Wizard' dialog box is displayed. 

 

4. Click 'Next'. A busy timer shows that updates are being searched. After the search is finished, you 

will get a message about availability / non-availability of updates. 

5. If updates are not available, click 'Cancel' to close the wizard. 

6. If updates are available, click 'Next' to download update files from the server. When the process is 

complete, the software will upgrade to the latest version. 

• Demo version of the software can not be updated. 

• If major version of the software is available, you have to purchase the software to upgrade it. 

  



How to Uninstall the Software? 

In two ways you can uninstall 'Stellar Phoenix Word Repair'. 

  

Click 'Start' -> 'All Programs' -> 'Stellar Toolkit for File Repair' -> 'Uninstall Stellar Toolkit for File 

Repair'. Follow on screen instructions to completely remove the software, including registry entries from 

your computer. 

  

Click 'Start' -> 'Control Panel' -> 'Add or Remove Program'. Select 'Stellar Toolkit for File Repair' entry 

from the displayed list and click 'Change/Remove'. Follow on screen instructions to completely remove the 

software as well as registry entries from your computer. 

  



 

 

Stellar Support 

Our 'Technical Support' professionals will give solutions for all your queries related to 'Stellar' products. 

You can either Call Us or Go Online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/file-repair/file-repair-software/buy-

now.php  

Chat Live with an Online technician at http://stellarinfo.com/ 

Search in our extensive 'Knowledgebase' at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to 'Stellar Support' at support@stellarinfo.com 

  

Support Helpline 

Monday to Friday [ 24 Hours a day ] 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders   orders@stellarinfo.com 

  

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com
mailto:orders@stellarinfo.com?subject=Purchase%20Order


Select Files 

You can add individual file, all files in a single folder or multiple files in 'Stellar Phoenix Word Repair' 

software for repair. 

To add files: 

Select 'Add File' option from 'File' menu. 

'Stellar Phoenix Word Repair' dialog box opens as shown here: 

 

To select a single 'Word' file 

1. Click 'Select File' button, locate 

and select the required 'Word' file 

in the 'Open' dialog box. Click 

'Open'. 

  

To select all 'Word' files in a single 

folder: 

1. Click 'Select Folder' option. 

2. In the Browse For Folder dialog 

box, browse and select the required 

Folder or drive. Click OK. 

  

To select multiple 'Word' files: 

1. Specify drive to search for files in 

'Look in' list box. 

2. Click 'Find File(s)' option. 

When you select 'Select Folder' or 'Find File(s)' option, the application starts searching for 'Word' files in 

the specified folder/drive and displays a list of files found accordingly. 



 

 

 

  

  

1. Select the check boxes of files that 

needs to be repaired. 'Scan' button 

will be enabled. 

2. Now you can start the process of 

scanning by pressing 'Scan' button. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



Preview Files 

After scanning, 'Stellar Phoenix Word Repair' shows preview of corrupted 'Word' files. It helps you 

evaluate files before repairing. You can view the content of files in three different formats - 'Full document', 

'Filtered text' and 'Raw text'. These file previews are available according to the state of the damage. In 

case of severely damaged files, the software provides plain text preview of the file content in 'Filtered text' 

and 'Raw text' view. 

To preview a file, click on it in the left pane. File's preview will be displayed in the right pane of the application 

window. 

To preview the file: 

Click on file in the left pane or right click and select 'Preview'. Click 'Full Document,' 'Filtered Text' or 

'Raw Text' tab in the middle-box of main user interface, to preview files in 'Word' format or in plain text. 

• Full Document View 

This will show preview of document in 'Microsoft Word' format. It shows all formatting, embedded 

images, text formatting, hyperlinks and other attributes of document. 

 

• Filtered Text View 

This shows the content of documents in plain text. Click 'Filtered Text' tab to view this format. 



 

 

 

• Raw Text View 

This shows content of the file as machine-readable text. Preview in raw format is available for .doc 

files only. To view files in this format, select .doc file from the tree and select 'Raw Preview' from 

'Tools'  menu. 'Raw Text'  tab will appear. Click this tab to see file preview. 

 

  

'Raw Text' tab is displayed only when 'Raw Preview' option is selected from the 'Tools' menu. 

This option is available for .doc files only. 



 

Repair Word Files 

'Stellar Phoenix Word Repair' repairs 'Microsoft Word' files and allows you to save them at your preferred 

location. You can repair individual or multiple files using the software. In addition, you can save the repaired 

files in original 'Word' document format, in plain text format, or in machine-readable format. 

To repair corrupt 'Microsoft Word' files: 

1. Select File to be repaired and start scanning. 

2. Preview files and decide upon the format you want to save the file in. 

3. Select the check boxes of files that needs to be repaired. Now you have two options: 

• Save: This option is available for .doc and .docx files both. 

• Advance Repair: This option is available for .doc files only. 

  

 

  

Click 'Save' option from the File menu or 

right click on selected file and choose 

'Save' option from the drop down menu. 

'Save Document' dialog box opens as 

shown. 

Select 'Default Location' or 'Select New 

Folder'. Former will save the file to its 

original location from where it is selected. 

Latter allows you to specify new 

destination. 

Decide whether to save files in 'Full 

Document', 'Filtered Text' or 'Raw Text' 

format and click 'OK'. Repair process will 

start and file(s) will be saved in desired 

format at specified location. 

  

  
  

Click 'Advance Repair' option from the File 

menu or right click on selected file and choose 



 

 

 

'Advance Repair' option from the drop down 

menu. You will be asked for destination to save 

file(s) as shown in the figure on left. 

  

Here, choose either default or new location as the 

destination for saving file(s) and click 'OK'. All 

selected files will be repaired and saved at the 

specified location. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 



Remove File from Tree View 

You can remove files from the 'Stellar Phoenix Word Repair' node displayed after scanning of files. If 

there are undesired files in tree, you can remove these files without closing the software. 

To remove files: 

1. Select the check boxes of files need to be removed. 

2. Select 'Remove File' option in 'File' menu. 

3. A dialog box will appear, click 'Yes' to remove the selected files. 

By default, all files are checked when you add files in the tree. If you click 'Remove File' icon, all files 

will be removed. Therefore, ensure that you select the required files only. 

  



 

 

Log Report 

Log window shows the progress of the current process. The log window displays messages such as 

beginning of the process, end of the process, name of the corrupted file, etc. 

  

 

• To enable log window 

o In File menu, select Message Log. 

o To save log information 

o In Tools menu, select Save Log. In Save As dialog box, specify the destination where log file 

should be saved. Click Save. 

o To clear log information 

o In Tools menu, select Clear Log. 

  



FAQs 

What does the demo version of  'Stellar Phoenix Word Repair' do? 

Demo version of the software only scans file(s) and shows their preview. To save repaired file(s), you need 

to purchase and register the software. 

  

Can I use 'MS Word' while 'Stellar Phoenix Word Repair' software is running? 

No, please make sure that 'MS Word' is closed while 'Stellar Phoenix Word Repair' is running. 

  

Can I view my original file after repairing? 

Yes, you can view your original file because 'Stellar Phoenix Word Repair' does not make any changes 

in the original file but saves the repaired file as another file. 

  

What styles, formats and objects are repaired in 'Word' document using 'Stellar Phoenix Word 

Repair'? 

'Stellar Phoenix Word Repair' preserves formatting of original document and repairs text, font color, font 

size, and hyperlinks of the document. The software also repairs tables, embedded images, and other 

attributes of 'Word' files like header and footer. 

  

I have forgotten the location of corrupted ' MS Word' file to be repaired. Can the software help me 

find those files? 

Yes, 'Stellar Phoenix Word Repair' gives you option to search for 'Word' file(s). For full instructions, please 

refer 'To select multiple files' option in Select File topic of this help manual. 

  

I can not see any button or menu for 'Raw Text Preview'. How can I go for it? 

It is very simple. After scanning the word file, select Raw Preview from Tools menu to preview raw text. 

This option is only available for Word document files only (*.doc). 

  

Can I repair my password protected word file using 'Stellar Phoenix Word Repair' software? 

'Stellar Phoenix Word Repair' software can repair all word files except password protected ones. So 

ensure that the file you are trying to repair is not a password protected one. 

  



 

 

Legal Notices 

Copyright 

Stellar Toolkit for File Repair software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

  

Copyright © Stellar Information Technology Private Limited. INDIA. 

Trademarks 

Stellar Toolkit for File Repair® is a registered trademark of Stellar Information Technology Private 

Limited. 

Windows 2000®, 2003®, XP®, Windows Vista®, Windows 7® and Windows 8® are registered trademarks 

of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective companies. 

Disclaimers 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR 

OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 

MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE 

LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

 



License Agreements 

Stellar Toolkit for File Repair 

Copyright © Stellar Information Technology Private Limited. INDIA. 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Toolkit for File Repair. 
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END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, 

ACCESSING OR USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU 

(HEREINAFTER “CUSTOMER”) ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT 

WHICH WILL BIND YOU. THE TERMS OF THIS LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS 

ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE 

SOFTWARE AND DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION 

PROCESS NOW, AND PROMPTLY RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO 

THE PARTY FROM WHOM YOU ACQUIRED THE SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper 

Corner, 88, Nehru Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware 

configuration as stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and 

manipulates it for a specific result based on a sequence of instructions, including without limitation desktop 

computers, laptops, tablets, mobile devices, telecommunication devices, Internet-connected devices, and 

hardware products capable of operating a wide variety of productivity, entertainment, or other software 

applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is used; 

for example, and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume 

license) granted by Stellar. 

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not 

limited to: (i) all software files and other computer information; (ii) any proprietary scripting logic embedded 

within exported file formats (iii)images, sounds, clip art, video and other works bundled with Stellar software 

or made available by Stellar on Stellar’s website for use with the Stellar software and not obtained from 

Stellar through a separate service (unless otherwise noted within that service) or from another party 

(“Content Files”); (iv) related explanatory written materials and files (“Documentation”); and (v) any modified 

versions and copies of, and upgrades, updates, and additions to, such information, provided to Customer 

by Stellar at any time, to the extent not provided under separate terms (collectively, “Updates”). 

2. LICENSE GRANT; PROPRIETARY RIGHTS 



Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants Customer 

a non-exclusive, non-transferable right, revocable and limited license to access and use the Software and 

Documentation on a single computer or workstation in a single location for your personal purposes (if you 

are a consumer) or your internal business purposes (if you are a business user) subject to the terms stated 

below. Customer must use the Technician License if using the software to provide professional or paid 

service to a third party (individual or company) and / or for any commercial purposes.   

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a single 

USER on a single computer at any one time. Consequently, the SOFTWARE must not be installed, 

displayed, shared or used concurrently from the computer or on distinct computers. Single User License is 

granted to customer who is using STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of 

the Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a specified 

number of USERS representing an equivalent number of computers. The SOFTWARE must not be 

installed, displayed, shared or used from or on a number of computers greater than the number of 

workstations authorized. Multiple User License are associated with Technician & Toolkit Edition of the 

Software. MAXIMUM Installation and usage limit of this License in on 3 Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which 

can be downloaded for free from Stellar’s website. The Software may only be installed and used on 

Permitted Number of Compatible Computers during the License Term for demonstration, evaluation, and 

training purposes only. Evaluation Software or Trial version of the Software may be freely distributed, if the 

distribution package is not modified. No person or company may charge a fee for the distribution of trial 

version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), 

Customer may install and use the Subscription License only on the Permitted Number of Compatible 

Computer during the License Term Period. Subject to the Permitted Number of Computers for the 

Subscription License, Customer agrees that Stellar may change the type of Software (such as specific 

components, versions, platforms, languages, etc.) included in the Subscription License at any time and 

shall not be liable to the Customer whatsoever for such change. Ongoing access to a Subscription License 

requires a recurring Internet connection to activate, renew, and validate the license. If Stellar does not 

receive the recurring subscription payment or cannot validate the license periodically, then the Software 

may become inactive without additional notice until Stellar receives the payment or validates the license. 

3.3 Lifetime License: Once registered, user is granted an exclusive license to use the Software for 

maximum period of 10 years on the same computer with same configuration and operating system which 

is compatible with the software. If the computer hardware or software is changed during the lifetime of the 



 

 

license which is not compatible with the original purchased version; then user may need to additionally 

purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT.      

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. 

Queries regarding the installation and use of the software should be submitted by e-mail which get 

responded usually within 24 Business Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater than 

1 year then you may avail Technical Support by paying additional fee applicable at that time. Paid support 

can be purchased for Lifetime License only upto a maximum period of next 2 years. Stellar will not assist 

customers for any support request related to the Software after 3 years from the purchase of the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual property of and are 

owned by Stellar. The structure, organization, and source code of the Software are the valuable trade 

secrets and confidential information of Stellar Information Technology Pvt. Ltd. The Software is protected 

by law, including but not limited to the copyright laws of the United States and other countries, and by 

international treaty provisions. Except as expressly stated herein, this agreement does not grant Customer 

any intellectual property rights in the Software. All rights not expressly granted are reserved by Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without limitation Documentation) 

that Customer makes must contain the same copyright and other proprietary notices that appear on or in 

the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this 

agreement and that it will not use the Software in a manner inconsistent with its design or Documentation. 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative Works 

of the Software or the Documentation; combine or merge any part of the Software or Documentation with 

or into any other software or documentation; or refer to or otherwise use the Software as part of any effort 

to develop software (including any routine, script, code, or program) having any functional attributes, visual 

expressions or other features similar to those of the Software to compete with Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis 

relating to the Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or otherwise 

attempt to discover the source code of the Software. 

6.5 No Unbundling. The Software may include various applications and components, may allow access to 

different Stellar Online Channels, may support multiple platforms and languages, and may be provided to 



Customer on multiple media or in multiple copies. Nonetheless, the Software is designed and provided to 

Customer as a single product to be used as a single product on Computers as permitted herein. Unless 

otherwise permitted in the Documentation, Customer is not required to install all component parts of the 

Software, but Customer shall not unbundle the component parts of the Software for use on different 

Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product 

identification or proprietary rights notices, seal or instructional label printed or stamped on, affixed to, or 

encoded or recorded in or on any Software or Documentation; or fail to preserve all copyright and other 

proprietary notices in all copies Company makes of the Software and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-

demand computing environment unless Company’s Grant Letter or the applicable Product Entitlement 

Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the software 

(including without limitation, software obtained through a web download), or authorize any portion of the 

software to be copied onto another individual or legal entity’s computer except as may be expressly 

permitted herein. 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the Documentation 

anywhere in the world belong to, or are licensed to Stellar.  The rights granted to you in the Software are 

licensed (not sold), and you have no rights in, or to, the Software or the Documentation other than the right 

to use them in accordance with the terms of this License. The Software, its source code and Documentation 

are proprietary products of Stellar Information Technology Pvt. Ltd. (“Stellar”) to provide the License and 

are protected by copyright and other intellectual property laws. Stellar shall at all times retain all rights, title, 

interest, including intellectual property rights, in the Software or Documentation. 

8. WARRANTIES.  

The licensed software (excluding the media on which it is distributed) and all Stellar related websites and 

services are provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors 

make NO WARRANTY as to their use or performance. Stellar and its suppliers and licensors make NO 

WARRANTIES OR REPRESENTATIONS (express or implied, whether by statute, common law, custom, 

usage, or otherwise) as to any matter including without limitation to quality, availability, performance or 

functionality of the licensed software or any related Stellar websites or services; quality or accuracy of any 

information obtained from or available through use of the licensed software or related Stellar websites or 

services; any representation or warranty that the use of the licensed software or any related Stellar websites 

or services will be uninterrupted or always available (whether due to internet failure or otherwise), error-

free, free of viruses or other harmful components or operate on or with any particular hardware, platform or 



 

 

software; non-infringement of third-party rights, merchantability, integration, satisfactory quality, or fitness 

for any particular purpose, except for, and only to the extent, that a warranty may not be excluded or limited 

by applicable law in licensee’s jurisdiction. 

9. DATA PROTECTION.   

You understand that by using the Licensed Software, you consent and agree to the collection and use of 

certain information about you and your use of the Licensed Software in accordance with Stellar’s Privacy 

Policy. You further consent and agree that Stellar may collect, use, transmit, process and maintain 

information related to your Account, and any devices or computers registered thereunder, for purposes of 

providing the Licensed Software, and any features therein, to you. Information collected by Stellar when 

you use the Licensed Software may also include technical or diagnostic information related to your use that 

may be used by Stellar to support, improve and enhance Stellar’s products and services. For more 

information please read our full privacy policy at “https://www.stellarinfo.com”, on the section Privacy Policy. 

You further understand and agree that this information may be transferred to the United States, India and/or 

other countries for storage, processing and use by Stellar, its affiliates, and/or their service providers. You 

hereby agree and consent to Stellar’s and its partners’ and licensors’ collection, use, transmission, 

processing and maintenance of such location and account data to provide and improve such features or 

services. 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without notice, 

to automatically connect to the Internet and to communicate with Stellar website or Stellar domain for 

purposes such as license validation and providing Customer with additional information, features, or 

functionality. Unless otherwise specified in Sections 10.2 through 10.5, the following provisions apply to all 

automatic Internet connections by the Software: 

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, 

whether automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy 

allows tracking of website visits and it addresses in detail the topic of tracking and use of cookies, web 

beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is 

collected and transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available 

at https://www.stellarinfo.com/ under Privacy Policy section. 

10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional 

information such as Customer’s ID, user name, and password may be transmitted to and stored by Stellar 

pursuant to the Privacy Policy and additional terms of use related to such Stellar Online Service. 

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to 

facilitate the Stellar Online Service or the activation or registration of the Software or Stellar Online Service, 

https://www.stellarinfo.com/
https://www.stellarinfo.com/


or (b) deliver in-product marketing to provide information about the Software and other Stellar products and 

Services using information including but not limited to platform version, version of the Software, license 

status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to automatically 

connect to the Internet (intermittently or on a regular basis) to (a) check for Updates that are available for 

download to and installation on the Computer and (b) notify Stellar of the results of installation attempts. 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) 

activate or reactivate the Software, (c) register the software, or (d) validate the Ownership. Such 

requirement may cause Customer’s Computer to connect to the Internet without notice on install, on launch, 

and on a regular basis thereafter. Once connected, the Software will collect and transmit information to 

Stellar. Software or Customer may also receive information from Stellar related to Customer’s license, 

subscription, or Ownership. Stellar may use such information to detect or prevent fraudulent or unauthorized 

use not in accordance with a valid license, subscription, or Ownership. Failure to activate or register the 

Software, validate the subscription or Ownership, or a determination by Stellar of fraudulent or unauthorized 

use of the Software may result in reduced functionality, inoperability of the Software, or a termination or 

suspension of the subscription or Ownership. 

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice 

and on an intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s 

access to content and services that are provided by Stellar or third parties. In addition, the Software may, 

without additional notice, automatically connect to the Internet to update downloadable materials from these 

online services so as to provide immediate availability of these services even when Customer is offline. 

10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded files 

(e.g., applications and/or content) and the publishers of those files. For example, Stellar uses digital 

certificates to help Customer identify the publisher of Stellar applications. Customer’s Computer may 

connect to the Internet at the time of validation of a digital certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential 

damages whatsoever (including, without limitation, damages for loss of business profits, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability 

to use the software product or the provision of or failure to provide support services, even if Stellar has 

been advised of the possibility of such damages. In any case, Stellar’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product or a sum of US Dollars Five 

whichever is higher. 

12. TERMINATION       



 

 

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from 

Stellar, Stellar may terminate this EULA, whereupon all rights granted to Customer shall immediately cease 

including but not limited to the license granted to the customer to use the software which shall also stand 

revoked. Furthermore, upon termination, Customer shall return to Stellar all copies of the Licensed 

Software, or verify in writing that all copies of the Licensed Software have been destroyed and failure of the 

customer  to do so would entitle Stellar to sue for relief in equity and damages. 

13. JURISDICTION AND LAW 

13.1 This EULA is subject to, and will be governed by and construed in accordance with the substantive 

laws applicable to the state of Delhi (India). Courts at Delhi, India alone shall have the jurisdiction to 

entertain any dispute arising out of the terms and conditions of this EULA and you consent to such 

jurisdiction of the courts at Delhi, India. 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United Nations 

Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on the subject matter 

and merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements.  

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, 

howsoever caused; but this survival shall not imply or create any continued right to use the Licensed 

Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed 

Software in any manner prohibited by the applicable export control laws, notably where applicable, the 

United States Export Administration Act, restrictions, or regulations (collectively the 'Export Laws'.) All rights 

to use the Licensed Software are granted on condition that Licensee complies with the Export Laws, and 

all such rights are forfeited if Licensee fails to comply with the Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved 

under the copyright laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, having 

its registered office at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019. 

14.5 There are no third party beneficiaries of any promises, obligations or representations made by 

Stellar herein.  

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a 

waiver by Stellar of any other or future violation of the same provision or any other provision of this License. 

14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior or 

contemporaneous representations, discussions, undertakings, communications, agreements, 



arrangements, advertisements, and understandings regulating the Licensed Software. This EULA is binding 

on and made for the benefit of the parties and their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized 

officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



 

 

About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. More 

Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

  

For more information about us, please visit www.stellarinfo.com. 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/


 

 

 

  

 

Stellar Repair for Excel 6.0 

User Guide 

  

  



 

Overview 

Stellar Repair for Excel is designed to repair corrupted Microsoft Excel (.xls and .xlsx) files that malfunction 

due to virus attack, software failure or unexpected system shut down. This software scans all selected Excel 

files and uses an advanced algorithm to restore Excel files back to their original state. The repaired files 

can either be saved to their original location on the hard disk, or to any user-specified location. 

You can preview the Excel files before saving to a location. You can search for Excel files in folders and 

drives. You can save all or individual files. In addition, you can save files to original location or specific 

location. 

Key Features of Stellar Repair for Excel 

• New and Enhanced GUI. 

• Multiple DPI support. 

• Select Folder option to choose all the Excel files within a folder. 

• Repairs user defined chart. 

• Repairs Chartsheet. 

• Repairs Chart Formatting. 

• Repairs cell comment (for binary format). 

• Repairs Series trendline.   

• Repairs Conditional formatting rules. 

• Repairs worksheet property( freeze panes, split, gridlines, formula bar).   

• Repairs sort and filter setting. 

• Repairs group and subtotal. 

• Repairs images, charts and engineering formulas. 

• Repairs same height of rows and columns. 

• Repairs all Cell Comments (for Excel 2007,Excel 2010 only). 



• Repairs all merge cells. 

• Repairs all hidden sheets and columns. 

• Repairs all shared formulas. 

• Repairs all text, numbers and tables from original Excel sheet. 

• Preserves formatting when restoring files. 

• Repairs all embedded functions from the original Excel sheet. 

• Supports MS Excel 2019, 2016, 2013, 2010, 2007, 2003 and 2000. 

• Compatible with Windows 10 / 8.1 / 8 / 7 / Vista / XP. 

  



Installation Procedure 

Before installing the software, ensure that your computer meets the minimum system requirements. 

Minimum System Requirements: 

• Processor : Pentium Class 

• Operating System : Windows 10 / 8.1 / 8 / 7 / Vista / XP 

• Memory : 2 GB minimum (4 GB recommended)  

• Hard Disk : 250 MB of free space 

• MS Excel : 2019 / 2016 / 2013 / 2010 / 2007 / 2003 / 2000 

To install the software: 

1. Double-click StellarToolkitforFileRepair.exe. Setup dialog box is displayed. 

2. Click Next to continue. License Agreement dialog box is displayed. 

3. Select I accept the Agreement option. Click Next. 

4. Specify the location where the installation files are to be stored. Click Next. 

5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click 
Browse to select a different location. Click Next. 

6. In the Select Additional Tasks dialog box, select check boxes as per your choice. Click Next. 

7. Review your selections. Click Back if you want to make any change. Click Install to start installation. 
The Installing window shows the installation process. 

8. After completion of the process, Completing the  Stellar Toolkit for File Repair Setup Wizard 
window opens. Click Finish. 

Note: Clear Launch Stellar Toolkit for File Repair check box before clicking Finish to prevent the 
software from launching. 

  



Launching the Software 

To launch Stellar Repair for Excel in Windows 10: 

• Click Start icon -> All apps -> Stellar Toolkit for File Repair -> Repair Spreadsheet Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop -> Repair Spreadsheet Or, 

• Click Stellar Toolkit for File Repair tile on the home screen -> Repair Spreadsheet.  

To launch Stellar Repair for Excel in Windows 8.1 / 8: 

• Click Stellar Toolkit for File Repair tile on the home screen and then click Repair Spreadsheet.. 
Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair 

Spreadsheet. Or, 

To start the application, do one of the following in Windows 7 / Vista / XP: 

• Click Start -> All Programs -> Stellar Toolkit for File Repair ->Repair Spreadsheet. Or, 

• Double click the Stellar Toolkit for File Repair icon on the desktop and then click Repair 
Spreadsheet. Or, 

• Click Stellar Toolkit for File Repair icon in Quick launch and then click Repair Spreadsheet. 

  



User Interface 

The main user interface of Stellar Repair for Excel is as shown below. 

 

With 'Ribbons' and 'Buttons' on the user interface, you can access its various features quite easily. 

  



Ribbons 

These are the ribbons and options in the Stellar Repair for Excel software. 

File Ribbon 

 

Select File 

Use this option to add Excel files to the software for 

repair. 

Remove File 

Use this option to remove selected files from the 

tree view. 

Save File 

Use this option to start the repairing process. 

Stop 

Use this option to stop an ongoing repairing 

process. 

Status Bar and Message Log 

Check/Uncheck these boxes to view or hide the 

Status Bar and Message Log. 

  

Tools Ribbon 

 

Save Log 

Use this option to save log information in a text file. 

Clear Log 

Use this option to clear the log information from 

Message log pane. 

Update 



Use this option to check for both, latest minor and 

latest major versions available online. 

  

Help Ribbon 

 

  

Help Topics 

Use this option to open help manual for the 

software. 

Support 

Use this option to view the support page. 

Knowledgebase 

Use this option to visit Knowledgebase articles of 

stellarinfo.com 

About 

Use this option to read information about the 

software. 

  

Buy Online Ribbon 

 

  

Buy Online 

Use this option to buy the software online. 

Activation 

Use this option to activate the software. 

  

  

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


Buttons 

Stellar Repair for Excel software has the following buttons: 

 

Click this button to select the file which you want to repair. 

 

Click this button to remove the selected files for repair. 

 

Click this button to save the repaired file. 

 

Click this button to stop an ongoing repairing process. 

 

Click this button to save the log report, which contains the details of the repairing 

process. 

 

Click this button to clear the log information from Message log pane. 

 

Click this button to update your software. Use this option to check for both, major 

and minor versions of the software. 



 

Click this button to view the help manual for the software. 

 

Click this button to view support page of stellarinfo.com. 

 

Click this button to visit the Knowledgebase articles of stellarinfo.com 

 

Click this button to read more information about the software. 

 

Click this buy button to purchase the software. 

 

Click this button to activate the software. 

 

Click this button to search for files located in your drives. 

 

Click this button to clear the list of files found in the system. 

 

Click this button to scan the files which you want to repair. 

http://www.stellarinfo.com/
http://www.stellarinfo.com/
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


Ordering the Software 

Click  https://www.stellarinfo.com/file-repair/file-repair-toolkit.php to know more about Stellar Toolkit for 
File Repair. 

To purchase the software online, please visit https://www.stellarinfo.com/file-repair/file-repair-
software/buy-now.php. 

Alternatively, click on Buy Online icon in Buy Online Ribbon to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a key will be sent to you through e-mail, which would be required to activate 
the software. 

  

  

https://www.stellarinfo.com/file-repair/file-repair-toolkit.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


Activating the Software 

The demo version is for evaluation purpose only. You need to activate the software to use its full 

functionality. Use the Activation Key received via email after purchasing the software to activate it. 

To activate the software: 

1. Run Stellar Repair for Excel. 

2. Click the Activation button. Activation window is displayed as shown below: 

  

 

  

3. If you don't have the activation key, click Get it now button in the window to purchase the 

software. 

4. Once the order is confirmed, an Activation Key is sent to the email that you have provided while 

purchasing the software. 

5. Paste or type the Activation Key (received through email after purchasing the product) and click 

Activate button (Please ensure an active Internet connection). 

6. Stellar Repair for Excel automatically communicates with the license server to verify the entered 

key. If the entered key is valid, activation is completed successfully. 

7. 'Activation Completed Successfully' message is displayed. Click OK. 

  



Updating the Software 

Stellar releases periodical software updates for Stellar Toolkit for File Repair software. You can update 
the software to keep it up-to-date. These updates can add a new functionality, feature, service, or any other 
information that can improve the software. Update option of the application is capable of checking for latest 
updates. This will check for both latest minor and major versions available online. You can easily download 
minor version through the update wizard. However, the major version, if available, has to be purchased. 
While updating the software, it’s recommended to close all the running programs. Note that demo version 
of the software cannot be updated. 

To start Stellar Toolkit for File Repair Update Wizard: 

1. Run Stellar Toolkit for File Repair software. 

2. Click Repair Spreadsheet. 

3. Select Update from Tools Ribbon.  

4. Update window pops up. 

5. The wizard will start searching for the latest updates and if it finds any new version, a window will 

pop up indicating the availability an update. 

6. Click Next and the software will start downloading update files from the server. When the process 

is complete, the software will updated to the latest version. 

Live Update may not happen due to following reasons: 

• Internet connection failure 

• Unable to download configuration files 

• Unable to locate updated files or version 

• Unable to locate executable file 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 

You can either Call Us or Go Online to our support section http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/file-repair/file-repair-software/buy-

now.php  

  

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


Enable Add-in in Excel 

Stellar Repair for Excel requires additional settings to be updated to MS Excel in order to function properly. 

Or else, it will display the following dialog box: 

 

To enable add-in in MS Excel 2002 and 2003: 

• Go to Tools Ribbon. 

• Click on Add-ins. Check the Analysis ToolPak box. 

• Click OK. 

  

To enable add-in in MS Excel 2007: 

• Click on Files Ribbon. 

• Go to Excel Options. Click on Add-ins.  

• Under Manage tab, choose Excel Add-ins option. Click GO. 

• Check the Analysis ToolPak box. 

• Click OK. 

  

To enable add-in in MS Excel 2010 and above: 

• Click on Files Ribbon. 

• Go to Options. Click on Add-ins.  

• Under Manage tab, choose Excel Add-ins option. Click GO. 

• Check the Analysis ToolPak box. 

• Click OK. 

  



Select Excel Files 

You can select multiple Excel files in the Excel Repair software. In addition, you can specify a folder or a 

volume as a folder such that all Excel files can be added from that folder. 

 

To select the files: 

1. Click Select File button from File ribbon. 

2. In the Select File dialog box, click Browse. Select the file which you want to repair from the desired 

location.  

3. Click Scan. The contents of the scanned files are displayed in the left pane of the screen. 

Note: Click Clear List if you want to clear the list of selected files. 

  



Search Excel Files 

You can search for Microsoft Excel files in your computer by using search option of the software. In case, 

you are unaware of the exact location of required file you can search the file easily. 

 

To search files from drive / folder: 

1. In the Select File dialog box, click Search. 

2. In the Select Folder dialog box, select a drive from Look in list box. All files that are found are 

listed in the Stellar Repair for Excel box. 

3. Select the file which you want to repair from the desired location. Click Scan.  

The contents of the scanned files are displayed in the left pane of the screen. 

  



Preview and Save Excel Files 

Stellar Repair for Excel repairs and saves corrupt excel files either to a default location, or to a user-

specified location. You can also preview the repaired database before saving it. 

To preview the file, double-click on the required file in the tree view in the 
left pane. 

 

  

To save Excel files: 

1. All selected files are listed in the left pane. On Home ribbon, select Save File. In the Save File 

dialog box, select either Default location or Select New Folder. Former will save the file to its 

original location from where it is added. Latter allows you to specify new location. 



          

 

  

2. Click OK. Saving process starts. 

 

3. The selected files are saved at the specified location. 



 

Note: The demo version of the software will only display the preview of Sheet 1 contents for each repaired 

excel file. 

  



Remove Files 

You can remove files from the Stellar Repair for Excel node. If some files are added that are not required 

then you can remove these files without exiting the Excel Repair software. 

To remove files: 

1. Check the check boxes of file that needs to be removed. 

2. Select Remove File option from Home ribbon. All selected files will be removed. 

Note: By default, all files are checked when you add files in the tree. If you click Remove File option all 

files will be removed. Therefore, ensure that you checked or cleared the check boxes of required file. 

  



View Log Report 

Log window shows the progress of the current process. The log window displays messages such as 

indicating the beginning of the process, end of the process, name of the corrupted file. 

• To enable log window 

o Check the Message Bar check box in View section of Home Ribbon. 

• To save the Log Report 

o Select Save Log from Tools Ribbon. 

o In Save As dialog box, specify the destination where log file should be saved. Click Save. 

• To clear the Log Report 

o Select Clear Log from Tools Ribbon. 

  



FAQs 

1. What is Stellar Repair for Excel? 

Stellar Repair for Excel is designed to repair corrupted Microsoft Excel (.xls and .xlsx) files. This 

software scans all selected Excel files and uses an advanced algorithm to restore Excel files back 

to their original state. The repaired files can either be saved to their original location on the hard disk, 

or to any user-specified location. 

2. I have forgotten the path of my Excel file, can I search the Excel file using the application? 

Yes, Excel files can be searched in a drive or a specified folder. Click 'Search' option in the Stellar 

Repair for Excel application and follow the process. 

3. What are the limitations of the demo version of the software? 

Demo version of software is just to show you the possibility of repair. If you are satisfied with the 

demo then you can purchase full version of software. You can repair corrupted file with full version 

software. 

4. How to repair multiple Excel files at same time? 

To repair multiple files at same time, you have to add all of them into the software. To add multiple 

files: 

• On File ribbon, select Select File. 

• In the Select File dialog box, click Search. 

• In the Browse for Folder dialog box, browse and select the required folder or volume. 

Click OK. 

• In the Stellar Repair for Excel dialog box, all files that are found in the selected folder or 

volume are listed. Check the check boxes of files that needs to be repaired. Click Scan. All 

files will be listed in the left pane under Stellar Repair for Excel node. 

• Follow the repair process. 

5. How much time Stellar Repair for Excel will take to repair the file? 

The scanning time depends upon the corruption level, size and number of Excel sheets. If the 

process is running that means that software is still scanning the corrupted file and you have to wait 

for scanning process to complete. Once scanning is complete you will get the repaired file at the 

selected destination. 

6. I want to analyze the repair process. Can I see the log report at a later stage? 

Yes, the application gives you option to save and view log report at a later stage. To save log report, 

• On the Tools ribbon, click Save Log. 



• Log report is saved at the specified location in text format. 

• To view the report, visit the location and open the file. 

  



Legal Notices 

Copyright 

Stellar Toolkit for File Repair software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. INDIA. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR 

OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 

MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE 

LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

Trademarks 

Stellar Toolkit for File Repair® is a registered trademark of Stellar Information Technology Private 

Limited. 

Windows 7®, Windows 8®, Windows 8.1® and Windows 10® are registered trademarks of Microsoft® 

Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective companies. 

 

 

 



END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, 

ACCESSING OR USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU 

(HEREINAFTER “CUSTOMER”) ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT 

WHICH WILL BIND YOU. THE TERMS OF THIS LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS 

ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE 

SOFTWARE AND DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION 

PROCESS NOW, AND PROMPTLY RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO 

THE PARTY FROM WHOM YOU ACQUIRED THE SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper 

Corner, 88, Nehru Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware 

configuration as stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and 

manipulates it for a specific result based on a sequence of instructions, including without limitation desktop 

computers, laptops, tablets, mobile devices, telecommunication devices, Internet-connected devices, and 

hardware products capable of operating a wide variety of productivity, entertainment, or other software 

applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is used; 

for example, and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume 

license) granted by Stellar. 

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not 

limited to: (i) all software files and other computer information; (ii) any proprietary scripting logic embedded 

within exported file formats (iii)images, sounds, clip art, video and other works bundled with Stellar software 

or made available by Stellar on Stellar’s website for use with the Stellar software and not obtained from 

Stellar through a separate service (unless otherwise noted within that service) or from another party 

(“Content Files”); (iv) related explanatory written materials and files (“Documentation”); and (v) any modified 

versions and copies of, and upgrades, updates, and additions to, such information, provided to Customer 

by Stellar at any time, to the extent not provided under separate terms (collectively, “Updates”). 

2. LICENSE GRANT; PROPRIETARY RIGHTS 



Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants Customer 

a non-exclusive, non-transferable right, revocable and limited license to access and use the Software and 

Documentation on a single computer or workstation in a single location for your personal purposes (if you 

are a consumer) or your internal business purposes (if you are a business user) subject to the terms stated 

below. Customer must use the Technician License if using the software to provide professional or paid 

service to a third party (individual or company) and / or for any commercial purposes.   

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a single 

USER on a single computer at any one time. Consequently, the SOFTWARE must not be installed, 

displayed, shared or used concurrently from the computer or on distinct computers. Single User License is 

granted to customer who is using STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of 

the Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a specified 

number of USERS representing an equivalent number of computers. The SOFTWARE must not be 

installed, displayed, shared or used from or on a number of computers greater than the number of 

workstations authorized. Multiple User License are associated with Technician & Toolkit Edition of the 

Software. MAXIMUM Installation and usage limit of this License in on 3 Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which 

can be downloaded for free from Stellar’s website. The Software may only be installed and used on 

Permitted Number of Compatible Computers during the License Term for demonstration, evaluation, and 

training purposes only. Evaluation Software or Trial version of the Software may be freely distributed, if the 

distribution package is not modified. No person or company may charge a fee for the distribution of trial 

version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), 

Customer may install and use the Subscription License only on the Permitted Number of Compatible 

Computer during the License Term Period. Subject to the Permitted Number of Computers for the 

Subscription License, Customer agrees that Stellar may change the type of Software (such as specific 

components, versions, platforms, languages, etc.) included in the Subscription License at any time and 

shall not be liable to the Customer whatsoever for such change. Ongoing access to a Subscription License 

requires a recurring Internet connection to activate, renew, and validate the license. If Stellar does not 

receive the recurring subscription payment or cannot validate the license periodically, then the Software 

may become inactive without additional notice until Stellar receives the payment or validates the license. 

3.3 Lifetime License: Once registered, user is granted an exclusive license to use the Software for 

maximum period of 10 years on the same computer with same configuration and operating system which 

is compatible with the software. If the computer hardware or software is changed during the lifetime of the 



license which is not compatible with the original purchased version; then user may need to additionally 

purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT.      

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. 

Queries regarding the installation and use of the software should be submitted by e-mail which get 

responded usually within 24 Business Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater than 

1 year then you may avail Technical Support by paying additional fee applicable at that time. Paid support 

can be purchased for Lifetime License only upto a maximum period of next 2 years. Stellar will not assist 

customers for any support request related to the Software after 3 years from the purchase of the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual property of and are 

owned by Stellar. The structure, organization, and source code of the Software are the valuable trade 

secrets and confidential information of Stellar Information Technology Pvt. Ltd. The Software is protected 

by law, including but not limited to the copyright laws of the United States and other countries, and by 

international treaty provisions. Except as expressly stated herein, this agreement does not grant Customer 

any intellectual property rights in the Software. All rights not expressly granted are reserved by Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without limitation Documentation) 

that Customer makes must contain the same copyright and other proprietary notices that appear on or in 

the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this 

agreement and that it will not use the Software in a manner inconsistent with its design or Documentation. 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative Works 

of the Software or the Documentation; combine or merge any part of the Software or Documentation with 

or into any other software or documentation; or refer to or otherwise use the Software as part of any effort 

to develop software (including any routine, script, code, or program) having any functional attributes, visual 

expressions or other features similar to those of the Software to compete with Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis 

relating to the Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or otherwise 

attempt to discover the source code of the Software. 



6.5 No Unbundling. The Software may include various applications and components, may allow access to 

different Stellar Online Channels, may support multiple platforms and languages, and may be provided to 

Customer on multiple media or in multiple copies. Nonetheless, the Software is designed and provided to 

Customer as a single product to be used as a single product on Computers as permitted herein. Unless 

otherwise permitted in the Documentation, Customer is not required to install all component parts of the 

Software, but Customer shall not unbundle the component parts of the Software for use on different 

Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product 

identification or proprietary rights notices, seal or instructional label printed or stamped on, affixed to, or 

encoded or recorded in or on any Software or Documentation; or fail to preserve all copyright and other 

proprietary notices in all copies Company makes of the Software and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-

demand computing environment unless Company’s Grant Letter or the applicable Product Entitlement 

Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the software 

(including without limitation, software obtained through a web download), or authorize any portion of the 

software to be copied onto another individual or legal entity’s computer except as may be expressly 

permitted herein. 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the Documentation 

anywhere in the world belong to, or are licensed to Stellar.  The rights granted to you in the Software are 

licensed (not sold), and you have no rights in, or to, the Software or the Documentation other than the right 

to use them in accordance with the terms of this License. The Software, its source code and Documentation 

are proprietary products of Stellar Information Technology Pvt. Ltd. (“Stellar”) to provide the License and 

are protected by copyright and other intellectual property laws. Stellar shall at all times retain all rights, title, 

interest, including intellectual property rights, in the Software or Documentation. 

8. WARRANTIES.  

The licensed software (excluding the media on which it is distributed) and all Stellar related websites and 

services are provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors 

make NO WARRANTY as to their use or performance. Stellar and its suppliers and licensors make NO 

WARRANTIES OR REPRESENTATIONS (express or implied, whether by statute, common law, custom, 

usage, or otherwise) as to any matter including without limitation to quality, availability, performance or 

functionality of the licensed software or any related Stellar websites or services; quality or accuracy of any 

information obtained from or available through use of the licensed software or related Stellar websites or 



services; any representation or warranty that the use of the licensed software or any related Stellar websites 

or services will be uninterrupted or always available (whether due to internet failure or otherwise), error-

free, free of viruses or other harmful components or operate on or with any particular hardware, platform or 

software; non-infringement of third-party rights, merchantability, integration, satisfactory quality, or fitness 

for any particular purpose, except for, and only to the extent, that a warranty may not be excluded or limited 

by applicable law in licensee’s jurisdiction. 

9. DATA PROTECTION.   

You understand that by using the Licensed Software, you consent and agree to the collection and use of 

certain information about you and your use of the Licensed Software in accordance with Stellar’s Privacy 

Policy. You further consent and agree that Stellar may collect, use, transmit, process and maintain 

information related to your Account, and any devices or computers registered thereunder, for purposes of 

providing the Licensed Software, and any features therein, to you. Information collected by Stellar when 

you use the Licensed Software may also include technical or diagnostic information related to your use that 

may be used by Stellar to support, improve and enhance Stellar’s products and services. For more 

information please read our full privacy policy at “https://www.stellarinfo.com”, on the section Privacy Policy. 

You further understand and agree that this information may be transferred to the United States, India and/or 

other countries for storage, processing and use by Stellar, its affiliates, and/or their service providers. You 

hereby agree and consent to Stellar’s and its partners’ and licensors’ collection, use, transmission, 

processing and maintenance of such location and account data to provide and improve such features or 

services. 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without notice, 

to automatically connect to the Internet and to communicate with Stellar website or Stellar domain for 

purposes such as license validation and providing Customer with additional information, features, or 

functionality. Unless otherwise specified in Sections 10.2 through 10.5, the following provisions apply to all 

automatic Internet connections by the Software: 

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, 

whether automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy 

allows tracking of website visits and it addresses in detail the topic of tracking and use of cookies, web 

beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is 

collected and transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available 

at https://www.stellarinfo.com/ under Privacy Policy section. 

https://www.stellarinfo.com/
https://www.stellarinfo.com/


10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional 

information such as Customer’s ID, user name, and password may be transmitted to and stored by Stellar 

pursuant to the Privacy Policy and additional terms of use related to such Stellar Online Service. 

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to 

facilitate the Stellar Online Service or the activation or registration of the Software or Stellar Online Service, 

or (b) deliver in-product marketing to provide information about the Software and other Stellar products and 

Services using information including but not limited to platform version, version of the Software, license 

status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to automatically 

connect to the Internet (intermittently or on a regular basis) to (a) check for Updates that are available for 

download to and installation on the Computer and (b) notify Stellar of the results of installation attempts. 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) 

activate or reactivate the Software, (c) register the software, or (d) validate the Ownership. Such 

requirement may cause Customer’s Computer to connect to the Internet without notice on install, on launch, 

and on a regular basis thereafter. Once connected, the Software will collect and transmit information to 

Stellar. Software or Customer may also receive information from Stellar related to Customer’s license, 

subscription, or Ownership. Stellar may use such information to detect or prevent fraudulent or unauthorized 

use not in accordance with a valid license, subscription, or Ownership. Failure to activate or register the 

Software, validate the subscription or Ownership, or a determination by Stellar of fraudulent or unauthorized 

use of the Software may result in reduced functionality, inoperability of the Software, or a termination or 

suspension of the subscription or Ownership. 

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice 

and on an intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s 

access to content and services that are provided by Stellar or third parties. In addition, the Software may, 

without additional notice, automatically connect to the Internet to update downloadable materials from these 

online services so as to provide immediate availability of these services even when Customer is offline. 

10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded files 

(e.g., applications and/or content) and the publishers of those files. For example, Stellar uses digital 

certificates to help Customer identify the publisher of Stellar applications. Customer’s Computer may 

connect to the Internet at the time of validation of a digital certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential 

damages whatsoever (including, without limitation, damages for loss of business profits, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability 

to use the software product or the provision of or failure to provide support services, even if Stellar has 



been advised of the possibility of such damages. In any case, Stellar’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product or a sum of US Dollars Five 

whichever is higher. 

12. TERMINATION       

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from 

Stellar, Stellar may terminate this EULA, whereupon all rights granted to Customer shall immediately cease 

including but not limited to the license granted to the customer to use the software which shall also stand 

revoked. Furthermore, upon termination, Customer shall return to Stellar all copies of the Licensed 

Software, or verify in writing that all copies of the Licensed Software have been destroyed and failure of the 

customer  to do so would entitle Stellar to sue for relief in equity and damages. 

13. JURISDICTION AND LAW 

13.1 This EULA is subject to, and will be governed by and construed in accordance with the substantive 

laws applicable to the state of Delhi (India). Courts at Delhi, India alone shall have the jurisdiction to 

entertain any dispute arising out of the terms and conditions of this EULA and you consent to such 

jurisdiction of the courts at Delhi, India. 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United Nations 

Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on the subject matter 

and merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements.  

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, 

howsoever caused; but this survival shall not imply or create any continued right to use the Licensed 

Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed 

Software in any manner prohibited by the applicable export control laws, notably where applicable, the 

United States Export Administration Act, restrictions, or regulations (collectively the 'Export Laws'.) All rights 

to use the Licensed Software are granted on condition that Licensee complies with the Export Laws, and 

all such rights are forfeited if Licensee fails to comply with the Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved 

under the copyright laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, having 

its registered office at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019. 



14.5 There are no third party beneficiaries of any promises, obligations or representations made by 

Stellar herein.  

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a 

waiver by Stellar of any other or future violation of the same provision or any other provision of this License. 

14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior or 

contemporaneous representations, discussions, undertakings, communications, agreements, 

arrangements, advertisements, and understandings regulating the Licensed Software. This EULA is binding 

on and made for the benefit of the parties and their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized 

officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

is the world's foremost Data Care corporation, with expertise in Data Recovery, Data 
Erasure, Mailbox Conversion, and File Repair software and services. Stellar has been in existence from 
past 25+ years and is a customer centric, critically acclaimed, global data recovery, data migration & 
erasure solutions provider with cost effective solutions available for large corporate, SMEs & Home 
Users. 

Stellar has a strong presence across USA, Europe & Asia. 

Product Line: 

Stellar provides wide range of Do It Yourself (DIY) Software for Consumer as well as Software for 

Businesses: 

  

Data Recovery 

 

File Repair 

 

Data Erasure 

 

A widest range of data 
recovery software that helps 
you recover your valued data 
lost after accidental format, 

virus problems, software 
malfunction, file/directory 

deletion, or even sabotage! 

The most comprehensive 
range of file repair software 

for Windows, Mac and Linux. 
Recover your files, which 

have been infected by 
viruses, malwares or have 

been damaged by improper 
shutdown and other 

corruption-related issues. 

Best software for IT assets 
disposition. Secure and erase 
variety of storage media and 

files from PC/Laptop, 
Servers, Rack Drives or 

Mobile devices. Data once 
erased cannot be recovered 
by using any data recovery 

software or service.  

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

  

  

  

Email Repair & 
Converter 

 

Database Repair 

 

Email Backup Tools 

 

Robust applications to restore 
inaccessible mailboxes of MS 

Professional and reliable 
software to repair corrupt or 

Fully featured backup utilities 
that provides a 

https://www.stellarinfo.com/disk-recovery.php
https://www.stellarinfo.com/file-repair/file-repair-software.php
https://www.stellarinfo.com/data-erasure/data-eraser-windows.php


Exchange, Outlook, 
AppleMail, Thunderbird, 

Eudora, Spicebird, 
Entourage, and Pocomail 

mailbox. Also, tools to convert 
mailboxes and database files 
from one format to another. 

damaged database for 
Microsoft SQL Server, 

QuickBooks®, Microsoft 
Access, SQLite and many 

more. 

comprehensive solution in 
case of any disaster. These 
software facilitates taking 
back up of all your mails, 
contacts, tasks, notes, 

calendar entries, journals etc. 
with full & incremental backup 

options. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

  

  

  

Photo and Video Tools 

 

Utility Tools 

 

Stellar Toolkits 

 

Professional tools to rebuild 
damaged or corrupt photos, 
videos, audios, and other 

multimedia files, from Window 
and Mac systems. Recover 

files from hard drives, 
memory cards, iPods, USB 

flash drives, digital cameras, 
IBM Micro Drives and more. 

A range of utility software 
such as SpeedUp Mac, Drive 
Clone and Partition Manager 
for Mac systems as well as 

Password Recovery for 
Windows and Password 

Recovery for Windows Server 
based systems 

Stellar also provides toolkits 
that are combination of 

Powerful Tools Designed for 
Data Recovery, File repair, 

Mailbox repair and File 
Conversion. All in one power 
packed toolkits to meet the 

need of every business. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

  

For more information about us, please visit www.stellarinfo.com. 

https://www.stellarinfo.com/mail-recovery.php
https://www.stellarinfo.com/database-recovery.php
https://www.stellarinfo.com/backup-mail.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/toolkit.php
http://www.stellarinfo.com/


  

 

 

  

 

Stellar Repair for PowerPoint 

User Guide 4.0 

  

 

 

 

 

 

 



 

1.1. About Stellar Repair for PowerPoint 

Stellar Repair for PowerPoint is designed to repair corrupt or damaged Microsoft PowerPoint 

(.ppt/.pptx/.pptm) files. It thoroughly scans PowerPoint files and uses powerful algorithm to restore 

PowerPoint files back to their original state. 

It gives you option to search for PowerPoint files in folders and drives and displays preview of PowerPoint 

files before saving at a location. You can save files at original or desired location. In addition, you can 

also opt for Raw Repair if you are not satisfied with the results of normal repair. 

  

Key Features of Stellar Repair for PowerPoint 

• Repairs PowerPoint files with all formatting and attributes. 

• Repairs Header/footer/slide number. 

• Repairs Comments. 

• Repairs Charts. 

• Repairs Hyperlinks. 

• Repairs Auto shape. 

• Repairs word Art. 

• Repairs Ole object. 

• Repairs sound/video file. 

• Repairs Notes page. 

• Repairs Master and user defined slide. 

• Repairs forms, modules, and vba code. 

• Repairs Controls. 

• Repairs table. 

• Repairs power point macro enabled(.pptm) file. 

• Preserves everything while restoring files. 

• Supports MS PowerPoint 2019 / 2016 / 2013 / 2010 / 2007 / 2003. 

• Compatible with Windows 10 / 8.1 / 8 / 7  

 

 



1.3. Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/file-repair/file-repair-

software/buy-now.php. 

Chat Live with an Online technician at http://stellarinfo.com/support/ 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/ 

E-mail to Stellar Support at support@stellarinfo.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://stellarinfo.com/support/
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb
mailto:support@stellarinfo.com.


 

1.4. Legal Notices 

Copyright 

Stellar Toolkit for File Repair software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 

user manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Toolkit for File Repair® is a registered trademark of Stellar Information Technology Private 

Limited. 

Windows 7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of Microsoft® 

Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

 



END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, 

ACCESSING OR USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU 

(HEREINAFTER “CUSTOMER”) ACCEPT ALL THE TERMS AND CONDITIONS OF THIS 

AGREEMENT WHICH WILL BIND YOU. THE TERMS OF THIS LICENSE INCLUDE, IN PARTICULAR, 

LIMITATIONS ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE 

SOFTWARE AND DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION 

PROCESS NOW, AND PROMPTLY RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO 

THE PARTY FROM WHOM YOU ACQUIRED THE SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper 

Corner, 88, Nehru Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware 

configuration as stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and 

manipulates it for a specific result based on a sequence of instructions, including without limitation 

desktop computers, laptops, tablets, mobile devices, telecommunication devices, Internet-connected 

devices, and hardware products capable of operating a wide variety of productivity, entertainment, or 

other software applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is 

used; for example, and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume 

license) granted by Stellar. 

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not 

limited to: (i) all software files and other computer information; (ii) any proprietary scripting logic 

embedded within exported file formats (iii)images, sounds, clip art, video and other works bundled with 

Stellar software or made available by Stellar on Stellar’s website for use with the Stellar software and not 

obtained from Stellar through a separate service (unless otherwise noted within that service) or from 

another party (“Content Files”); (iv) related explanatory written materials and files (“Documentation”); and 

(v) any modified versions and copies of, and upgrades, updates, and additions to, such information, 

provided to Customer by Stellar at any time, to the extent not provided under separate terms (collectively, 

“Updates”). 



 

2. LICENSE GRANT; PROPRIETARY RIGHTS 

Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants 

Customer a non-exclusive, non-transferable right, revocable and limited license to access and use the 

Software and Documentation on a single computer or workstation in a single location for your personal 

purposes (if you are a consumer) or your internal business purposes (if you are a business user) subject 

to the terms stated below. Customer must use the Technician License if using the software to provide 

professional or paid service to a third party (individual or company) and / or for any commercial purposes. 

  

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a 

single USER on a single computer at any one time. Consequently, the SOFTWARE must not be installed, 

displayed, shared or used concurrently from the computer or on distinct computers. Single User License 

is granted to customer who is using STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition 

of the Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a 

specified number of USERS representing an equivalent number of computers. The SOFTWARE must not 

be installed, displayed, shared or used from or on a number of computers greater than the number of 

workstations authorized. Multiple User License are associated with Technician & Toolkit Edition of the 

Software. MAXIMUM Installation and usage limit of this License in on 3 Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which 

can be downloaded for free from Stellar’s website. The Software may only be installed and used on 

Permitted Number of Compatible Computers during the License Term for demonstration, evaluation, and 

training purposes only. Evaluation Software or Trial version of the Software may be freely distributed, if 

the distribution package is not modified. No person or company may charge a fee for the distribution of 

trial version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), 

Customer may install and use the Subscription License only on the Permitted Number of Compatible 

Computer during the License Term Period. Subject to the Permitted Number of Computers for the 

Subscription License, Customer agrees that Stellar may change the type of Software (such as specific 

components, versions, platforms, languages, etc.) included in the Subscription License at any time and 

shall not be liable to the Customer whatsoever for such change. Ongoing access to a Subscription 

License requires a recurring Internet connection to activate, renew, and validate the license. If Stellar 

does not receive the recurring subscription payment or cannot validate the license periodically, then the 

Software may become inactive without additional notice until Stellar receives the payment or validates the 

license. 



3.3 Lifetime License: Once registered, user is granted an exclusive license to use the Software for 

maximum period of 10 years on the same computer with same configuration and operating system which 

is compatible with the software. If the computer hardware or software is changed during the lifetime of the 

license which is not compatible with the original purchased version; then user may need to additionally 

purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT.      

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. 

Queries regarding the installation and use of the software should be submitted by e-mail which get 

responded usually within 24 Business Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater 

than 1 year then you may avail Technical Support by paying additional fee applicable at that time. Paid 

support can be purchased for Lifetime License only upto a maximum period of next 2 years. Stellar will 

not assist customers for any support request related to the Software after 3 years from the purchase of 

the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual property of and are 

owned by Stellar. The structure, organization, and source code of the Software are the valuable trade 

secrets and confidential information of Stellar Information Technology Pvt. Ltd. The Software is protected 

by law, including but not limited to the copyright laws of the United States and other countries, and by 

international treaty provisions. Except as expressly stated herein, this agreement does not grant 

Customer any intellectual property rights in the Software. All rights not expressly granted are reserved by 

Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without limitation Documentation) 

that Customer makes must contain the same copyright and other proprietary notices that appear on or in 

the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this 

agreement and that it will not use the Software in a manner inconsistent with its design or Documentation. 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative 

Works of the Software or the Documentation; combine or merge any part of the Software or 

Documentation with or into any other software or documentation; or refer to or otherwise use the Software 

as part of any effort to develop software (including any routine, script, code, or program) having any 

functional attributes, visual expressions or other features similar to those of the Software to compete with 



 

Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis 

relating to the Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or 

otherwise attempt to discover the source code of the Software. 

6.5 No Unbundling. The Software may include various applications and components, may allow access 

to different Stellar Online Channels, may support multiple platforms and languages, and may be provided 

to Customer on multiple media or in multiple copies. Nonetheless, the Software is designed and provided 

to Customer as a single product to be used as a single product on Computers as permitted herein. Unless 

otherwise permitted in the Documentation, Customer is not required to install all component parts of the 

Software, but Customer shall not unbundle the component parts of the Software for use on different 

Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product 

identification or proprietary rights notices, seal or instructional label printed or stamped on, affixed to, or 

encoded or recorded in or on any Software or Documentation; or fail to preserve all copyright and other 

proprietary notices in all copies Company makes of the Software and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-

demand computing environment unless Company’s Grant Letter or the applicable Product Entitlement 

Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the 

software (including without limitation, software obtained through a web download), or authorize any 

portion of the software to be copied onto another individual or legal entity’s computer except as may be 

expressly permitted herein. 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the Documentation 

anywhere in the world belong to, or are licensed to Stellar.  The rights granted to you in the Software are 

licensed (not sold), and you have no rights in, or to, the Software or the Documentation other than the 

right to use them in accordance with the terms of this License. The Software, its source code and 

Documentation are proprietary products of Stellar Information Technology Pvt. Ltd. (“Stellar”) to provide 

the License and are protected by copyright and other intellectual property laws. Stellar shall at all times 

retain all rights, title, interest, including intellectual property rights, in the Software or Documentation. 

8. WARRANTIES.  



The licensed software (excluding the media on which it is distributed) and all Stellar related websites and 

services are provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors 

make NO WARRANTY as to their use or performance. Stellar and its suppliers and licensors make NO 

WARRANTIES OR REPRESENTATIONS (express or implied, whether by statute, common law, custom, 

usage, or otherwise) as to any matter including without limitation to quality, availability, performance or 

functionality of the licensed software or any related Stellar websites or services; quality or accuracy of any 

information obtained from or available through use of the licensed software or related Stellar websites or 

services; any representation or warranty that the use of the licensed software or any related Stellar 

websites or services will be uninterrupted or always available (whether due to internet failure or 

otherwise), error-free, free of viruses or other harmful components or operate on or with any particular 

hardware, platform or software; non-infringement of third-party rights, merchantability, integration, 

satisfactory quality, or fitness for any particular purpose, except for, and only to the extent, that a warranty 

may not be excluded or limited by applicable law in licensee’s jurisdiction. 

9. DATA PROTECTION.   

You understand that by using the Licensed Software, you consent and agree to the collection and use of 

certain information about you and your use of the Licensed Software in accordance with Stellar’s Privacy 

Policy. You further consent and agree that Stellar may collect, use, transmit, process and maintain 

information related to your Account, and any devices or computers registered thereunder, for purposes of 

providing the Licensed Software, and any features therein, to you. Information collected by Stellar when 

you use the Licensed Software may also include technical or diagnostic information related to your use 

that may be used by Stellar to support, improve and enhance Stellar’s products and services. For more 

information please read our full privacy policy at “https://www.stellarinfo.com”, on the section Privacy 

Policy. You further understand and agree that this information may be transferred to the United States, 

India and/or other countries for storage, processing and use by Stellar, its affiliates, and/or their service 

providers. You hereby agree and consent to Stellar’s and its partners’ and licensors’ collection, use, 

transmission, processing and maintenance of such location and account data to provide and improve 

such features or services. 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without 

notice, to automatically connect to the Internet and to communicate with Stellar website or Stellar domain 

for purposes such as license validation and providing Customer with additional information, features, or 

functionality. Unless otherwise specified in Sections 10.2 through 10.5, the following provisions apply to 

all automatic Internet connections by the Software: 

https://www.stellarinfo.com/


 

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, 

whether automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy 

allows tracking of website visits and it addresses in detail the topic of tracking and use of cookies, web 

beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is 

collected and transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available 

at https://www.stellarinfo.com/ under Privacy Policy section. 

10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional 

information such as Customer’s ID, user name, and password may be transmitted to and stored by Stellar 

pursuant to the Privacy Policy and additional terms of use related to such Stellar Online Service. 

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to 

facilitate the Stellar Online Service or the activation or registration of the Software or Stellar Online 

Service, or (b) deliver in-product marketing to provide information about the Software and other Stellar 

products and Services using information including but not limited to platform version, version of the 

Software, license status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to 

automatically connect to the Internet (intermittently or on a regular basis) to (a) check for Updates that are 

available for download to and installation on the Computer and (b) notify Stellar of the results of 

installation attempts. 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) 

activate or reactivate the Software, (c) register the software, or (d) validate the Ownership. Such 

requirement may cause Customer’s Computer to connect to the Internet without notice on install, on 

launch, and on a regular basis thereafter. Once connected, the Software will collect and transmit 

information to Stellar. Software or Customer may also receive information from Stellar related to 

Customer’s license, subscription, or Ownership. Stellar may use such information to detect or prevent 

fraudulent or unauthorized use not in accordance with a valid license, subscription, or Ownership. Failure 

to activate or register the Software, validate the subscription or Ownership, or a determination by Stellar 

of fraudulent or unauthorized use of the Software may result in reduced functionality, inoperability of the 

Software, or a termination or suspension of the subscription or Ownership. 

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice 

and on an intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s 

access to content and services that are provided by Stellar or third parties. In addition, the Software may, 

without additional notice, automatically connect to the Internet to update downloadable materials from 

these online services so as to provide immediate availability of these services even when Customer is 

offline. 

https://www.stellarinfo.com/


10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded 

files (e.g., applications and/or content) and the publishers of those files. For example, Stellar uses digital 

certificates to help Customer identify the publisher of Stellar applications. Customer’s Computer may 

connect to the Internet at the time of validation of a digital certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential 

damages whatsoever (including, without limitation, damages for loss of business profits, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability 

to use the software product or the provision of or failure to provide support services, even if Stellar has 

been advised of the possibility of such damages. In any case, Stellar’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product or a sum of US Dollars Five 

whichever is higher. 

12. TERMINATION       

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from 

Stellar, Stellar may terminate this EULA, whereupon all rights granted to Customer shall immediately 

cease including but not limited to the license granted to the customer to use the software which shall also 

stand revoked. Furthermore, upon termination, Customer shall return to Stellar all copies of the Licensed 

Software, or verify in writing that all copies of the Licensed Software have been destroyed and failure of 

the customer  to do so would entitle Stellar to sue for relief in equity and damages. 

13. JURISDICTION AND LAW 

13.1 This EULA is subject to, and will be governed by and construed in accordance with the 

substantive laws applicable to the state of Delhi (India). Courts at Delhi, India alone shall have the 

jurisdiction to entertain any dispute arising out of the terms and conditions of this EULA and you consent 

to such jurisdiction of the courts at Delhi, India. 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United 

Nations Convention on Contracts for the International Sale of Goods, the application of which is expressly 

excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on the subject 

matter and merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements.  



 

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, 

howsoever caused; but this survival shall not imply or create any continued right to use the Licensed 

Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed 

Software in any manner prohibited by the applicable export control laws, notably where applicable, the 

United States Export Administration Act, restrictions, or regulations (collectively the 'Export Laws'.) All 

rights to use the Licensed Software are granted on condition that Licensee complies with the Export 

Laws, and all such rights are forfeited if Licensee fails to comply with the Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved 

under the copyright laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, 

having its registered office at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019. 

14.5 There are no third party beneficiaries of any promises, obligations or representations made by 

Stellar herein.  

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a 

waiver by Stellar of any other or future violation of the same provision or any other provision of this 

License. 

14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior 

or contemporaneous representations, discussions, undertakings, communications, agreements, 

arrangements, advertisements, and understandings regulating the Licensed Software. This EULA is 

binding on and made for the benefit of the parties and their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized 

officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



1.5. About Stellar 

is the world's foremost Data Care Corporation, with expertise in Data Recovery, Data 

Erasure, Mailbox Conversion, and File Repair software and services. Stellar has been in existence from 

past 25+ years and is a customer-centric, critically acclaimed, global data recovery, data migration & 

erasure solutions provider with cost-effective solutions available for large corporate, SMEs & Home 

Users. 

Stellar has a strong presence across USA, Europe & Asia. 

Product Line: 

Stellar provides a wide range of Do It Yourself (DIY) Software for Consumer as well as Software for 

Businesses: 

Data Recovery 

 

File Repair 

 

Data Erasure 

 

The widest range of data 

recovery software that helps 

you recover your valued data 

lost after accidental format, 

virus problems, software 

malfunction, file/directory 

deletion, or even sabotage! 

The most comprehensive 

range of file repair software 

for Windows, Mac and Linux. 

Recover your files, which 

have been infected by 

viruses, malwares or have 

been damaged by improper 

shutdown and other 

corruption-related issues. 

Best software for IT assets 

disposition. Secure and erase 

variety of storage media and 

files from PC/Laptop, 

Servers, Rack Drives or 

Mobile devices. Data once 

erased cannot be recovered 

by using any data recovery 

software or service.  

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

  

  

  

  

https://www.stellarinfo.com/disk-recovery.php
https://www.stellarinfo.com/file-repair/file-repair-software.php
https://www.stellarinfo.com/data-erasure/data-eraser-windows.php


 

Email Repair & 

Converter 

 

Database Repair 

 

Email Backup Tools 

 

Robust applications to restore 

inaccessible mailboxes of MS 

Exchange, Outlook, 

AppleMail, Thunderbird, 

Eudora, Spicebird, 

Entourage, and Pocomail 

mailbox. Also, tools to 

convert mailboxes and 

database files from one 

format to another. 

Professional and reliable 

software to repair corrupt or 

damaged database for 

Microsoft SQL Server, 

QuickBooks®, Microsoft 

Access, SQLite and many 

more. 

Fully featured backup utilities 

that provides a 

comprehensive solution in 

case of any disaster. These 

software facilitates taking 

back up of all your mails, 

contacts, tasks, notes, 

calendar entries, journals etc. 

with full & incremental backup 

options. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

  

  

  

Photo and Video Tools 

 

Utility Tools 

 

Stellar Toolkits 

 

Professional tools to rebuild 

damaged or corrupt photos, 

videos, audios, and other 

multimedia files, from 

Window and Mac systems. 

Recover files from hard 

drives, memory cards, iPods, 

USB flash drives, digital 

cameras, IBM Micro Drives 

and more. 

A range of utility software 

such as SpeedUp Mac, Drive 

Clone and Partition Manager 

for Mac systems as well as 

Password Recovery for 

Windows and Password 

Recovery for Windows Server 

based systems 

Stellar also provides toolkits 

that are combination of 

Powerful Tools Designed for 

Data Recovery, File repair, 

Mailbox repair and File 

Conversion. All in one power 

packed toolkits to meet the 

need of every business. 

https://www.stellarinfo.com/mail-recovery.php
https://www.stellarinfo.com/database-recovery.php
https://www.stellarinfo.com/backup-mail.php


 

Know More --> 

 

Know More --> 

 

Know More --> 

For more information about us, please visit www.stellarinfo.com. 

https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/toolkit.php
http://www.stellarinfo.com/


 

2.1. Installation Procedure 

Before installing the software, ensure that your computer meets the minimum system requirements. 

Minimum System Requirements: 

• Processor: Pentium Class 

• Operating System:  Windows 10 / Windows 8.1 / Windows 8 /  Windows 7   

• Memory: 2 GB minimum (4 GB recommended) 

• Hard Disk: 250 MB of free space 

• MS PowerPoint: 2019 / 2016 / 2013 / 2010 / 2007 / 2003 

To install the software: 

1. Double-click StellarToolkitforFileRepair.exe file to open Stellar Toolkit for File Repair Setup 

Wizard. 

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Click Next. Select Destination Location dialog box is 

displayed. 

4. Click Browse to select destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks 

dialog box is displayed. 

6. Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

7. Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

8. After completing the process, Completing the Stellar Toolkit for File Repair Setup Wizard 

window is displayed. Click Finish. 

Note: Clear Launch Stellar Toolkit for File Repair check box before clicking Finish to prevent the 

software from launching. 



2.2. Launching the Software 

To launch Stellar Repair for PowerPoint in Windows 10: 

• Click Start icon -> All apps -> Stellar Toolkit for File Repair -> Repair Presentation . Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair Presentation. 

Or, 

• Click Stellar Toolkit for File Repair tile on the home screen and then click Repair Presentation. 

To launch Stellar Repair for PowerPoint in Windows 8.1 / 8: 

• Click Stellar Toolkit for File Repair tile on the home screen and then click Repair Presentation. 

Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair Presentation. 

To launch Stellar Repair for PowerPoint in Windows 7: 

• Click Start -> Programs -> Stellar Toolkit for File Repair -> Repair Presentation. Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair Presentation. 

Or, 

• Click Stellar Toolkit for File Repair icon in Quick Launch and then click Repair Presentation. 

 

 

 

 

 

 

 

 

 

 

 

 



 

2.3. User Interface 

The main user interface of Stellar Repair for PowerPoint is as shown below: 

 

The user interface contains ribbons and buttons that lets you access various features of the software with 

ease. 

 

 

 

 

 

 

 

 

 

 

 



2.3.1. Ribbon 

Home Ribbon 

  

 

Select 

Use this option to add files to the software for 

repair. 

Remove  

Use this option to remove selected files from the 

tree view. 

Save 

Use this option to start the repairing process. 

Stop 

Use this option to stop an ongoing repairing 

process. 

Status Bar and Message Log 

Check/Uncheck these boxes to view or hide the 

Status Bar and Message Log. 

  

Tools Ribbon 

  

 

Save  

Use this option to save log information in a text 

file. 

Clear  

Use this option to clear the log information from 

Message log pane. 

Raw Repair 



 

Use this option to save .ppt file in raw format. 

Update 

Use this option to check for both, latest minor 

and latest major versions available online. 

  

  

Help Ribbon 

  

 

Help Topics 

Use this option to open help manual for the 

software. 

Support 

Use this option to view the support page. 

Knowledgebase 

Use this option to visit Knowledgebase articles 

of stellarinfo.com 

About 

Use this option to read information about the 

software. 

  

Buy Online Ribbon 

  

 

Buy Online 

Use this option to buy the software online. 

Activation 

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


Use this option to activate the software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

2.3.2. Buttons 

 

Click this button to select the file which you want to repair. 

 

Click this button to remove the selected files for repair. 

 

Click this button to save the repaired file. 

 

Click this button to stop an ongoing repairing process. 

 

Click this button to save the log report, which contains the details of the repairing 

process. 

 

Click this button to clear the log information from Message log pane. 

 

Click this button to save .ppt file in raw format. 

 

Click this button to update your software. Use this option to check for both, major and 

minor versions of the software. 



 

Click this button to view the help manual for the software. 

 

Click this button to view support page of stellarinfo.com. 

 

Click this button to visit the Knowledgebase articles of stellarinfo.com 

 

Click this button to read more information about the software. 

 

Click this button to purchase the software. 

 

Click this button to activate the software. 

 

Click this button to search for files located in your drives. 

 

Click this button to clear the list of files found in the system. 

 

Click this button to scan the files which you want to repair. 
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2.4. Ordering the Software 

To know more about Stellar Toolkit for File Repair, click here. 

To purchase the software online, please visit https://www.stellarinfo.com/file-repair/file-repair-

software/buy-now.php 

Alternatively, click on Buy Online icon in Buy Online ribbon on the Menu Bar to purchase the software 

online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, you receive a activation key through e-mail. You require this key to activate 

the software. 
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2.5. Activating the Software 

The demo version is just for evaluation purpose and must be eventually activated to use the full 

functionality of the software. The software can be activated using the Activation Key which you will 

receive via email after purchasing the software. 

To activate the software: 

1. Run demo version of the software. 

2. On Buy Online ribbon, click Activation button. Activation window is displayed as shown below: 

       

3. If you don't have the activation key, click Get it now button in the window to go online and purchase 

the product. 

4. Once the order is confirmed, an Activation Key gets sent to the email provided. 

5. Type the Activation Key (received through email after purchasing the product) and click Activate 

button (Please ensure that you have an active Internet connection). 

      

6. The software would automatically communicate with the license server to verify the entered key. If 

the key you entered is valid, the software will be activated successfully. 

7. 'Activation Completed Successfully ' message is displayed after the process gets completed 

successfully. Click OK 

 

 

 

 



 

2.6. Updating the Software 

Stellar releases periodical software updates for Stellar Toolkit for File Repair software. You can update 

the software to keep it up-to-date. These updates can add new functionality, feature, service, or any other 

information that can improve the software. Update option of the application is capable of checking for 

latest updates. It checks for both latest minor and major versions available online. While updating the 

software, it’s recommended to close all the running programs.  

To update Stellar Toolkit for File Repair: 

1. Run registered version of Stellar Toolkit for File Repair software. 

2. Click Repair Presentation button. 

3. Click Update icon from Tools Menu. 

4. Update Wizard window will open. Click Next. The wizard will search for latest updates, and if it 

finds any new updates, a window will pop up indicating its availability. 

5. Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

• Internet connection failure. 

• Updates are not available. 

• Unable to download configuration files 

• Unable to locate updated files or version 

• Unable to locate executable file 

 

 

 

 

 

 

 



3.1. Add Files 

To start the repairing process, you need to add files to the Stellar Repair for PowerPoint software. You 

can add a single file or multiple files to the software. In addition, you can specify a folder or a drive from 

which all PowerPoint files can be added. 

To add file to Stellar Repair for PowerPoint, 

Run Stellar Repair for PowerPoint software. Select File dialog box opens as shown below:  

 

You can also select file by Clicking on Select button from Home ribbon. 

To select the files: 

• Browse - Click Browse button to select corrupted PPT / PPTX / PPTM files 

• Search - Click Search button to locate the files you want to repair. 

           



 

          

  

For Browsing a particular file : 

1. In the Select File dialog box, click Browse. Select the file which you want to repair from the 

desired location.  

2. In the Open dialog box, locate and select the required PowerPoint file. The path of the selected 

file is displayed in File Path text box. Click Open. 

For Searching a particular file : 

1. In the Select File dialog box, click Search. Select the file which you want to repair from the 

desired location.  

2. In the Browse For Folder dialog box, browse and select the required Folder or drive. Click OK. 

3. All files found in the selected folder or drive is displayed in text box below, you can select / 

deselect or clear list according to you requirement. 

4. Check the check boxes of files that are to be repaired. 

5. Click Scan. The contents of the scanned files are displayed in the left pane of the screen. 



           

Note : Click Clear List if you want to clear the list of selected files. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

3.2. Preview Files 

After scanning, Stellar Repair for PowerPoint shows list of scanned files in a tree like structure under 

Stellar Repair for PowerPoint node in left pane of the application window. 

To preview the file, double-click on the required file in the tree view in the left pane. File's preview will be 

displayed in the right pane of the application window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3.3. Save Files 

To save PPT files: 

1. All selected files are listed in the left pane. On Home ribbon, select Save. In the Save File dialog 

box, select either Default location or other location. Former will save the file to its original 

location from where it is added. Latter allows you to specify new location. 

            

  

2. Click OK. Saving process starts. 

          

 

3. The selected files are saved at the specified location. 



 

 

  



3.4. Remove Files 

You can remove files from the Stellar Repair for PowerPoint node. If for some reason, you decide that 

some added files are not required then you can remove these files without exiting the software. 

To remove files: 

1. Check check box of the file that needs to be removed from the tree. 

2. Click Remove button from Home ribbon. All selected files will be removed. 

Note: By default, all files are checked when you add files in the tree. If you click Remove File option all 

files will be removed. Therefore, ensure that you checked or cleared the check boxes of required file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

3.5. View and Save log 

Log window shows details of the ongoing process. After scanning process, this pane shows information 

such as starting time and date of scanning process, name and size of selected files, and end time of 

scanning process. 

After repairing process, this pane shows information such as starting time and date of repairing process, 

name and size of selected files, file status and end time of repairing process. 

You can view log details in Message log pane at bottom of the application window as shown here: 

 

You can save as well as clear information displayed in Message log pane. 

 

To save log information 

• In Tools menu, select Save Log. In Browse For Folder dialog box, specify destination where log 

file should be saved. Click OK. 

To clear log information 

• In Tools menu, select Clear Log 



 

3.6. Raw Repair 

In case your powerpoint file is severely corrupted, the application allows you to repair and save it in a raw 

format. The Raw Repair feature is available only for the .ppt files. 

  

For Raw Repair of files : 

1. Click on Tools ribbon, select Raw Repair. All selected files are listed in the left pane.  

2. In the Save File dialog box, select either Default location or Other location.  

3. Former will save the file to its original location from where it is added. Latter allows you to specify 

new location. 

.          

 

 

 

 

 

 

 

 

 

 

 



 

4. Frequently Asked Questions (FAQ) 

What does the demo version of the software do? 

Demo version of the software is only for evaluation and shows preview of scanned PowerPoint files. To 

save repaired files you need to purchase and register the product. 

Does the software make changes to my original file? 

Stellar Repair for PowerPoint doesn't make any changes to the original file, and produces a new 

repaired file on the destination location. 

How to know whether the software will be able to repair my PowerPoint files or not? 

To know whether the software will be able to repair your corrupt PowerPoint files or not, please try demo 

version of the software. Scan your files using Stellar Repair for PowerPoint and preview results for your 

satisfaction. 

Does PowerPoint need to be installed on the system for previewing PowerPoint files? 

Yes, PowerPoint must be installed on the system to preview PowerPoint files. 

Does PowerPoint need to be installed on the system for repairing corrupt PowerPoint files? 

Yes, PowerPoint must be installed on the system to repair data from corrupt/damaged PowerPoint file. 

What is macro enabled(.pptm) file? 

Macro-enabled version of a PowerPoint presentation allows you to automate certain tasks. When you 

open a PowerPoint Presentation (.ppt, .pptx), the PowerPoint software is launched, but the presentation 

doesn't start automatically. If you want the presentation to start immediately in full screen mode and 

provide a more polished and professional experience, you should save it as a PowerPoint Show or as a 

.pptm file. 

How is .pptx file different from .ppt? 

PowerPoint .pptx Presentations are different than the .ppt version in that they use the Microsoft Office 

Open XML format. The Open XML format makes it easy for other programs, such as OpenOffice.org, to 

read .pptx files (and other Open XML file types). The Open XML format was introduced with Microsoft 

Office 2007. 

Can I repair multiple PowerPoint files simultaneously? 

Yes. To repair multiple files simultaneously, use Select Folder or Find File(s) option for adding files to the 

software. For full detail, please refer Add Files topic of this help manual. 

If the location of PowerPoint files is not known, can I search for then using 'Stellar Repair for 

PowerPoint'? 



Yes, Find File option of the software lets you search for PowerPoint files in specified drive of the 

computer. To know how to use this option, please refer Search File topic of this help manual. 

Does the software repair slides in the same order as they are in a PowerPoint file? 

Yes, the software keeps repaired slides in the same order as they were in the original PowerPoint file. 

What is Raw Repair? 

Raw Repair searches for signature of files. That means it repairs files based on signature. Raw Repair 

should be used when results of normal repairing process are not satisfactory. Raw Repair may take more 

time but has greater chance to discover lost data. Raw Repair option is available only for .ppt files. 

 



 

 

  

Stellar Repair for PDF 

User Guide for version 3.0 

  



 

1.1. About Stellar Repair for PDF 

Stellar Repair for PDF is an effective Windows-based PDF repair software that can repair damaged, 

corrupt or inaccessible PDF files. It restores all objects contained in PDF files, including hyperlinks, 

bookmarks, comments, header and footer, etc. 

Why would you need Stellar Repair for PDF? 

There are several reasons for why a PDF cannot be opened or viewed, no matter which program or browser 

we use. Sometimes, when sending PDF files, transferring them between systems or computers, or getting 

them from a hard drive that's a few years old, it can happen that the PDF files gets corrupted. It's also 

possible that the PDF broke while it was created. 

Stellar Repair for PDF repairs unlimited PDF files on your system without leaking out your confidential 

data online. The software is very well embedded with interactive graphical user–interface and any individual 

can easily follow instructions to retrieve corrupt PDF files or recover lost data in just a couple of clicks. This 

particular feature in turn proves very beneficial for any user to operate the tool without any professional 

assistance. 

Key Features: 

• Complete PDF File Repair: Absolute repairing of texts, labels, graphics, images and tables of 

damaged PDF documents. 

• Batch Repair: Effective in repairing batch of PDF files in a single repair cycle. 

• Recovers Interactive Objects: Recovery of interactive objects like hyperlinks, bookmarks, 

comments, notes etc. 

• Preview Before Saving: Option to preview the repaired PDF before saving. 

• Preserves Original File: Saves the repaired PDF data as a new PDF document and does not 

make changes to original file. 

• Compatible to all PDF Versions: Compatible with PDF versions 1.2, 1.3, 1.4, 1.5, 1.6 and 1.7. 

• Operating System: Compatible with Windows 10, Windows 8.1, Windows 8 and Windows 7 

  



1.3. Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/file-repair/file-repair-software/buy-

now.php  

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 
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1.4. Legal Notices 

Copyright 

Stellar Toolkit for File Repair software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR 

OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 

MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE 

LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

Trademarks 

Stellar Toolkit for File Repair® is a registered trademark of Stellar Information Technology Private 

Limited. 

Windows 10®, Windows 8® and Windows 7® are registered trademarks of Microsoft® Corporation Inc.  

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective companies. 

License Agreement 

Stellar Toolkit for File Repair 

Copyright © Stellar Information Technology Private Limited INDIA 

www.stellarinfo.com 

http://www.stellarinfo.com/


All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Toolkit for File Repair. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, 

ACCESSING OR USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU 

(HEREINAFTER “CUSTOMER”) ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT 

WHICH WILL BIND YOU. THE TERMS OF THIS LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS 

ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE 

SOFTWARE AND DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION 

PROCESS NOW, AND PROMPTLY RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO 

THE PARTY FROM WHOM YOU ACQUIRED THE SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper 

Corner, 88, Nehru Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware 

configuration as stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and 

manipulates it for a specific result based on a sequence of instructions, including without limitation desktop 

computers, laptops, tablets, mobile devices, telecommunication devices, Internet-connected devices, and 

hardware products capable of operating a wide variety of productivity, entertainment, or other software 

applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is used; 

for example, and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume 

license) granted by Stellar. 

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not 

limited to: (i) all software files and other computer information; (ii) any proprietary scripting logic embedded 

within exported file formats (iii)images, sounds, clip art, video and other works bundled with Stellar software 

or made available by Stellar on Stellar’s website for use with the Stellar software and not obtained from 

Stellar through a separate service (unless otherwise noted within that service) or from another party 

(“Content Files”); (iv) related explanatory written materials and files (“Documentation”); and (v) any modified 

versions and copies of, and upgrades, updates, and additions to, such information, provided to Customer 

by Stellar at any time, to the extent not provided under separate terms (collectively, “Updates”). 

2. LICENSE GRANT; PROPRIETARY RIGHTS 



Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants Customer 

a non-exclusive, non-transferable right, revocable and limited license to access and use the Software and 

Documentation on a single computer or workstation in a single location for your personal purposes (if you 

are a consumer) or your internal business purposes (if you are a business user) subject to the terms stated 

below. Customer must use the Technician License if using the software to provide professional or paid 

service to a third party (individual or company) and / or for any commercial purposes.   

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a single 

USER on a single computer at any one time. Consequently, the SOFTWARE must not be installed, 

displayed, shared or used concurrently from the computer or on distinct computers. Single User License is 

granted to customer who is using STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of 

the Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a specified 

number of USERS representing an equivalent number of computers. The SOFTWARE must not be 

installed, displayed, shared or used from or on a number of computers greater than the number of 

workstations authorized. Multiple User License are associated with Technician & Toolkit Edition of the 

Software. MAXIMUM Installation and usage limit of this License in on 3 Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which 

can be downloaded for free from Stellar’s website. The Software may only be installed and used on 

Permitted Number of Compatible Computers during the License Term for demonstration, evaluation, and 

training purposes only. Evaluation Software or Trial version of the Software may be freely distributed, if the 

distribution package is not modified. No person or company may charge a fee for the distribution of trial 

version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), 

Customer may install and use the Subscription License only on the Permitted Number of Compatible 

Computer during the License Term Period. Subject to the Permitted Number of Computers for the 

Subscription License, Customer agrees that Stellar may change the type of Software (such as specific 

components, versions, platforms, languages, etc.) included in the Subscription License at any time and 

shall not be liable to the Customer whatsoever for such change. Ongoing access to a Subscription License 

requires a recurring Internet connection to activate, renew, and validate the license. If Stellar does not 

receive the recurring subscription payment or cannot validate the license periodically, then the Software 

may become inactive without additional notice until Stellar receives the payment or validates the license. 

3.3 Lifetime License: Once registered, user is granted an exclusive license to use the Software for 

maximum period of 10 years on the same computer with same configuration and operating system which 

is compatible with the software. If the computer hardware or software is changed during the lifetime of the 



 

license which is not compatible with the original purchased version; then user may need to additionally 

purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT.  

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. 

Queries regarding the installation and use of the software should be submitted by e-mail which get 

responded usually within 24 Business Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater than 

1 year then you may avail Technical Support by paying additional fee applicable at that time. Paid support 

can be purchased for Lifetime License only upto a maximum period of next 2 years. Stellar will not assist 

customers for any support request related to the Software after 3 years from the purchase of the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual property of and are 

owned by Stellar. The structure, organization, and source code of the Software are the valuable trade 

secrets and confidential information of Stellar Information Technology Pvt. Ltd. The Software is protected 

by law, including but not limited to the copyright laws of the United States and other countries, and by 

international treaty provisions. Except as expressly stated herein, this agreement does not grant Customer 

any intellectual property rights in the Software. All rights not expressly granted are reserved by Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without limitation Documentation) 

that Customer makes must contain the same copyright and other proprietary notices that appear on or in 

the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this 

agreement and that it will not use the Software in a manner inconsistent with its design or Documentation. 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative Works 

of the Software or the Documentation; combine or merge any part of the Software or Documentation with 

or into any other software or documentation; or refer to or otherwise use the Software as part of any effort 

to develop software (including any routine, script, code, or program) having any functional attributes, visual 

expressions or other features similar to those of the Software to compete with Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis 

relating to the Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or otherwise 

attempt to discover the source code of the Software. 



6.5 No Unbundling. The Software may include various applications and components, may allow access to 

different Stellar Online Channels, may support multiple platforms and languages, and may be provided to 

Customer on multiple media or in multiple copies. Nonetheless, the Software is designed and provided to 

Customer as a single product to be used as a single product on Computers as permitted herein. Unless 

otherwise permitted in the Documentation, Customer is not required to install all component parts of the 

Software, but Customer shall not unbundle the component parts of the Software for use on different 

Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product 

identification or proprietary rights notices, seal or instructional label printed or stamped on, affixed to, or 

encoded or recorded in or on any Software or Documentation; or fail to preserve all copyright and other 

proprietary notices in all copies Company makes of the Software and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-

demand computing environment unless Company’s Grant Letter or the applicable Product Entitlement 

Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the software 

(including without limitation, software obtained through a web download), or authorize any portion of the 

software to be copied onto another individual or legal entity’s computer except as may be expressly 

permitted herein. 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the Documentation 

anywhere in the world belong to, or are licensed to Stellar.  The rights granted to you in the Software are 

licensed (not sold), and you have no rights in, or to, the Software or the Documentation other than the right 

to use them in accordance with the terms of this License. The Software, its source code and Documentation 

are proprietary products of Stellar Information Technology Pvt. Ltd. (“Stellar”) to provide the License and 

are protected by copyright and other intellectual property laws. Stellar shall at all times retain all rights, title, 

interest, including intellectual property rights, in the Software or Documentation. 

8. WARRANTIES.  

The licensed software (excluding the media on which it is distributed) and all Stellar related websites and 

services are provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors 

make NO WARRANTY as to their use or performance. Stellar and its suppliers and licensors make NO 

WARRANTIES OR REPRESENTATIONS (express or implied, whether by statute, common law, custom, 

usage, or otherwise) as to any matter including without limitation to quality, availability, performance or 

functionality of the licensed software or any related Stellar websites or services; quality or accuracy of any 

information obtained from or available through use of the licensed software or related Stellar websites or 

services; any representation or warranty that the use of the licensed software or any related Stellar websites 



 

or services will be uninterrupted or always available (whether due to internet failure or otherwise), error-

free, free of viruses or other harmful components or operate on or with any particular hardware, platform or 

software; non-infringement of third-party rights, merchantability, integration, satisfactory quality, or fitness 

for any particular purpose, except for, and only to the extent, that a warranty may not be excluded or limited 

by applicable law in licensee’s jurisdiction. 

9. DATA PROTECTION.   

You understand that by using the Licensed Software, you consent and agree to the collection and use of 

certain information about you and your use of the Licensed Software in accordance with Stellar’s Privacy 

Policy. You further consent and agree that Stellar may collect, use, transmit, process and maintain 

information related to your Account, and any devices or computers registered thereunder, for purposes of 

providing the Licensed Software, and any features therein, to you. Information collected by Stellar when 

you use the Licensed Software may also include technical or diagnostic information related to your use that 

may be used by Stellar to support, improve and enhance Stellar’s products and services. For more 

information please read our full privacy policy at “https://www.stellarinfo.com”, on the section Privacy Policy. 

You further understand and agree that this information may be transferred to the United States, India and/or 

other countries for storage, processing and use by Stellar, its affiliates, and/or their service providers. You 

hereby agree and consent to Stellar’s and its partners’ and licensors’ collection, use, transmission, 

processing and maintenance of such location and account data to provide and improve such features or 

services. 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without notice, 

to automatically connect to the Internet and to communicate with Stellar website or Stellar domain for 

purposes such as license validation and providing Customer with additional information, features, or 

functionality. Unless otherwise specified in Sections 10.2 through 10.5, the following provisions apply to all 

automatic Internet connections by the Software: 

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, 

whether automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy 

allows tracking of website visits and it addresses in detail the topic of tracking and use of cookies, web 

beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is 

collected and transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available 

at https://www.stellarinfo.com/ under Privacy Policy section. 

10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional 

information such as Customer’s ID, user name, and password may be transmitted to and stored by Stellar 

pursuant to the Privacy Policy and additional terms of use related to such Stellar Online Service. 

https://www.stellarinfo.com/
https://www.stellarinfo.com/


10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to 

facilitate the Stellar Online Service or the activation or registration of the Software or Stellar Online Service, 

or (b) deliver in-product marketing to provide information about the Software and other Stellar products and 

Services using information including but not limited to platform version, version of the Software, license 

status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to automatically 

connect to the Internet (intermittently or on a regular basis) to (a) check for Updates that are available for 

download to and installation on the Computer and (b) notify Stellar of the results of installation attempts. 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) 

activate or reactivate the Software, (c) register the software, or (d) validate the Ownership. Such 

requirement may cause Customer’s Computer to connect to the Internet without notice on install, on launch, 

and on a regular basis thereafter. Once connected, the Software will collect and transmit information to 

Stellar. Software or Customer may also receive information from Stellar related to Customer’s license, 

subscription, or Ownership. Stellar may use such information to detect or prevent fraudulent or unauthorized 

use not in accordance with a valid license, subscription, or Ownership. Failure to activate or register the 

Software, validate the subscription or Ownership, or a determination by Stellar of fraudulent or unauthorized 

use of the Software may result in reduced functionality, inoperability of the Software, or a termination or 

suspension of the subscription or Ownership. 

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice 

and on an intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s 

access to content and services that are provided by Stellar or third parties. In addition, the Software may, 

without additional notice, automatically connect to the Internet to update downloadable materials from these 

online services so as to provide immediate availability of these services even when Customer is offline. 

10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded files 

(e.g., applications and/or content) and the publishers of those files. For example, Stellar uses digital 

certificates to help Customer identify the publisher of Stellar applications. Customer’s Computer may 

connect to the Internet at the time of validation of a digital certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential 

damages whatsoever (including, without limitation, damages for loss of business profits, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability 

to use the software product or the provision of or failure to provide support services, even if Stellar has 

been advised of the possibility of such damages. In any case, Stellar’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product or a sum of US Dollars Five 

whichever is higher. 



 

12. TERMINATION  

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from 

Stellar, Stellar may terminate this EULA, whereupon all rights granted to Customer shall immediately cease 

including but not limited to the license granted to the customer to use the software which shall also stand 

revoked. Furthermore, upon termination, Customer shall return to Stellar all copies of the Licensed 

Software, or verify in writing that all copies of the Licensed Software have been destroyed and failure of the 

customer  to do so would entitle Stellar to sue for relief in equity and damages. 

13. JURISDICTION AND LAW 

13.1 This EULA is subject to, and will be governed by and construed in accordance with the substantive 

laws applicable to the state of Delhi (India). Courts at Delhi, India alone shall have the jurisdiction to 

entertain any dispute arising out of the terms and conditions of this EULA and you consent to such 

jurisdiction of the courts at Delhi, India. 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United Nations 

Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on the subject matter 

and merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements.  

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, 

howsoever caused; but this survival shall not imply or create any continued right to use the Licensed 

Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed 

Software in any manner prohibited by the applicable export control laws, notably where applicable, the 

United States Export Administration Act, restrictions, or regulations (collectively the 'Export Laws'.) All rights 

to use the Licensed Software are granted on condition that Licensee complies with the Export Laws, and 

all such rights are forfeited if Licensee fails to comply with the Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved 

under the copyright laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, having 

its registered office at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019. 

14.5 There are no third party beneficiaries of any promises, obligations or representations made by 

Stellar herein.  

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a 

waiver by Stellar of any other or future violation of the same provision or any other provision of this License. 



14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior or 

contemporaneous representations, discussions, undertakings, communications, agreements, 

arrangements, advertisements, and understandings regulating the Licensed Software. This EULA is binding 

on and made for the benefit of the parties and their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized 

officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



 

1.5. About Stellar 

 is the world's foremost Data Care Corporation, with expertise in Data Recovery, Data 

Erasure, Mailbox Conversion, and File Repair software and services. Stellar has been in existence from 

past 25+ years and is a customer-centric, critically acclaimed, global data recovery, data migration & 

erasure solutions provider with cost-effective solutions available for large corporate, SMEs & Home Users. 

Stellar has a strong presence across USA, Europe & Asia. 

Product Line: 

Stellar provides a wide range of Do It Yourself (DIY) Software for Consumer as well as Software for 

Businesses: 

  

Data Recovery 

 

File Repair 

 

Data Erasure 

 

The widest range of data 

recovery software that helps 

you recover your valued data 

lost after accidental format, 

virus problems, software 

malfunction, file/directory 

deletion, or even sabotage! 

The most comprehensive 

range of file repair software 

for Windows, Mac and Linux. 

Recover your files, which 

have been infected by 

viruses, malwares or have 

been damaged by improper 

shutdown and other 

corruption-related issues. 

Best software for IT assets 

disposition. Secure and erase 

variety of storage media and 

files from PC/Laptop, 

Servers, Rack Drives or 

Mobile devices. Data once 

erased cannot be recovered 

by using any data recovery 

software or service.  

 

Know More --> 

 

Know More --> 

 

Know More --> 

  
  

  

https://www.stellarinfo.com/disk-recovery.php
https://www.stellarinfo.com/file-repair/file-repair-software.php
https://www.stellarinfo.com/data-erasure/data-eraser-windows.php


  

Email Repair & 

Converter 

 

Database Repair 

 

Email Backup Tools 

 

Robust applications to restore 

inaccessible mailboxes of MS 

Exchange, Outlook, 

AppleMail, Thunderbird, 

Eudora, Spicebird, 

Entourage, and Pocomail 

mailbox. Also, tools to convert 

mailboxes and database files 

from one format to another. 

Professional and reliable 

software to repair corrupt or 

damaged database for 

Microsoft SQL Server, 

QuickBooks®, Microsoft 

Access, SQLite and many 

more. 

Fully featured backup utilities 

that provides a 

comprehensive solution in 

case of any disaster. These 

software facilitates taking 

back up of all your mails, 

contacts, tasks, notes, 

calendar entries, journals etc. 

with full & incremental backup 

options. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

  

  

  

Photo and Video Tools 

 

Utility Tools 

 

Stellar Toolkits 

 

Professional tools to rebuild 

damaged or corrupt photos, 

videos, audios, and other 

multimedia files, from Window 

A range of utility software 

such as SpeedUp Mac, Drive 

Clone and Partition Manager 

for Mac systems as well as 

Stellar also provides toolkits 

that are combination of 

Powerful Tools Designed for 

Data Recovery, File repair, 

https://www.stellarinfo.com/mail-recovery.php
https://www.stellarinfo.com/database-recovery.php
https://www.stellarinfo.com/backup-mail.php


 

and Mac systems. Recover 

files from hard drives, 

memory cards, iPods, USB 

flash drives, digital cameras, 

IBM Micro Drives and more. 

Password Recovery for 

Windows and Password 

Recovery for Windows Server 

based systems 

Mailbox repair and File 

Conversion. All in one power 

packed toolkits to meet the 

need of every business. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

For more information about us, please visit www.stellarinfo.com. 

https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/toolkit.php
http://www.stellarinfo.com/


 2.1. Installation Procedure 

Before installing the software, ensure that your system meets the minimum system requirements: 

Minimum System Requirements 

Processor: Pentium Class 

Operating System: Windows 10 / Windows 8.1 / Windows 8 / Windows 7 

Memory: Minimum 2 GB (Recommended 4 GB) 

Hard Disk: 250 MB of Free Space 

To install the software, follow these steps: 

1. Double-click StellarToolkitforFileRepair.exe executable file to start installation. Setup - Stellar 

Toolkit for File Repair dialog box is displayed. 

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

6. Select check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

7. Review your selections. Click Back if you want to change them. Click Install to start installation. 

The Installing window shows the installation process. 

8. On completion of the installation process, Completing the Stellar Toolkit for File Repair Setup 

Wizard window is displayed. Click Finish. 

Note: Clear Launch Stellar Toolkit for File Repair check box to prevent the software from launching 

automatically. 

  



 

2.2. Launching the Software 

To launch Stellar Repair for PDF in Windows 10: 

• Click Start icon -> All apps -> Stellar Toolkit for File Repair -> Repair PDF . Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair PDF. Or, 

• Click Stellar Toolkit for File Repair tile on the home screen and then click Repair PDF. 

To launch Stellar Repair for PDF in Windows 8.1 / 8: 

• Click Stellar Toolkit for File Repair tile on the home screen and then click Repair PDF. Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair PDF. 

To launch Stellar Repair for PDF in Windows 7: 

• Click Start -> Programs -> Stellar Toolkit for File Repair -> Repair PDF. Or, 

• Double click Stellar Toolkit for File Repair icon on the desktop and then click Repair PDF Or, 

• Click Stellar Toolkit for File Repair icon in Quick Launch and then click Repair PDF. 

  



2.3. User Interface 

Stellar Repair for PDF software's main user interface is as shown below. 

 

The user interface contains buttons that let you access various features of the software with ease. 

  



 

2.3.1. Buttons 

 

Add File 

Click this button to locate and add the desired PDF files that you want to 

repair. 

 

Add 

Click this button to locate and add more PDF files to the list of files to be 

repaired. 

 

Select All 

Select this option to select or deselect all the listed files. 

 

Repair 

Click this button to start the repairing process. 

 

Stop 

Click this button to stop the ongoing process. 

 

Previous 

Click this button to preview the previous PDF page. 

 

Next 

Click this button to preview the next PDF page. 



 

Save Repaired Files 

Click this button to save the repaired PDF files. 

 

Menu 

Click this button to show/hide the menu bar. 

 

About 

Click this button to read information about the software. 

 

Help 

Click this button to open the help manual of the software. 

 

Update 

Click this button to update the software. 

 

Buy 

Click this button to buy online. 

 

Activation 

Click this button to activate the software after purchasing. 

  

https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


 

2.4. Ordering the Software 

Click https://www.stellarinfo.com/file-repair/file-repair-toolkit.php to know more about Stellar Toolkit for 

File Repair. 

The software can be purchased online. For price details and to place an order, 

https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php 

Once the order is confirmed, an activation key will be sent to you through e-mail, which would be required 

to activate the software. 

  

https://www.stellarinfo.com/file-repair/file-repair-toolkit.php
https://www.stellarinfo.com/file-repair/file-repair-software/buy-now.php


2.5. Activating the Software 

The demo version is for evaluation purpose only. You need to activate the software to use it's full 

functionality. Use the Activation Key received via e-mail after purchasing the software to activate it. 

To activate the software: 

1. Run the demo version of the software. 

2. Click the Activation button. Activation window is displayed as shown below: 

 

3. If you don't have the activation key, click Get it now button in the window to purchase the software. 

Once the order is confirmed, an Activation Key is sent to the e-mail that you have provided while 

purchasing the software. 

4. Paste or type the Activation Key (received through e-mail after purchasing the product) and click 

Activate button (Please ensure an active Internet connection). 

 

5. The software automatically communicates with the license server to verify the entered key. If the 

entered key is valid, activation is completed successfully. 

6. 'Activation Completed Successfully' message is displayed. Click OK. 

  



 

2.6. Updating the Software 

Stellar releases periodical software updates for Stellar Toolkit for File Repair software. You can update 

the software to keep it up-to-date. These updates can add a new functionality, feature, service, or any other 

information that can improve the software. Update option of the application is capable of checking for latest 

updates. It checks for both latest minor and major versions available online. While updating the software, 

it’s recommended to close all the running programs. 

  

To update Stellar Toolkit for File Repair, do the following steps: 

1. Run activated version of Stellar Toolkit for File Repair software. 

2. Click Repair PDF button. 

3. If updates are available, Update window is displayed automatically. Alternatively, click Update icon 

from Support Menu. 

4. Stellar Update Wizard window opens. Click Next. The wizard will search for latest updates, and if 

it finds any new updates, a window will pop up indicating its availability. 

5. Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

• Internet connection failure. 

• Updates are not available. 

• Unable to download configuration files. 

• Unable to locate updated files or version. 

  



3. Working with the Software 

3.1. Add and Repair PDF Files 

3.2. Preview and Save PDF Files 

  



 

3.1. Add and Repair PDF Files 

Stellar Repair for PDF repairs corrupt and damaged PDF files and allows you to save to them at a location 

of your choice. You can repair single or multiple files by using Stellar Repair for PDF. 

To add PDF and Repair files, do the following steps: 

1. Run Stellar Repair for PDF software, the main interface appears as follows: 

 

2. On the main interface, click Add File button. The Select File dialog box appears. 

3. Select the PDF files that you want to repair and click Open. 

4. The added files are displayed as shown below: 



 

5. To add more files, click the Add button. 

6. By default, all the files in the list are checked and will be repaired. If you do not want files to be 

repaired from the list, uncheck the files using the  button. 

7. Click on Repair button to start the repairing process. 

8. The following screen shows that the repairing is in progress. Click on Stop button to stop the 

ongoing process. 



 

 

9. Once the repairing process is completed, the following dialog box appears. Click OK to close the 

dialog box. 

 

10. The repaired files are shown in the preview window, refer to Preview and Save PDF files. 

  



3.2. Preview and Save PDF files 

The repaired PDF files can be viewed in the preview mode and saved at any desired location. 

To preview and save the repaired files, do the following steps: 

1. In the preview window, select a file in the left pane. The preview will appear on the right pane. 

 

2. Click on   to preview the next page and   to preview the previous page. 

3. By default, all the files of the list in the left pane are checked and will be saved. If you do not want 

files to be saved from the list, uncheck the files using the  button. 

4. Click Save Repaired Files button. Browse for Folder dialog box is displayed. 

5. Choose the folder to specify a location for saving the repaired files and click OK. 

Note: Click on Make New Folder to create a new folder at the selected location. 

6. The following screen shows that the saving is in progress. Click on Stop button to stop the ongoing 

process. 



 

 

7. Saving Complete dialog box is displayed which gives a hyperlink to the folder containing the saved 

PDF files. 

 

8. Click OK to close the dialog box. 

Note: 

• Saved PDF files are renamed as Repaired_[file name]_ Date_Time.pdf. 

• In the demo version of the software, preview is available for the first ten pages of the repaired PDF 

files and the saving option is not available. 

  



4. Frequently Asked Questions (FAQ) 

1. What PDF versions can be repaired by Stellar Repair for PDF software? 

Files of version PDF 1.2 thru 1.7 can be repaired by Stellar Repair for PDF. 

  

2. Can I repair multiple PDF files using this software? 

Yes, you can repair multiple PDF file at a time using Stellar Repair for PDF. 

  

3. Can I repair a password protected PDF file? 

No, you cannot repair a corrupt PDF file if it is password protected or there is any kind of restriction 

on it. 

  

4. How to know whether the software will be able to recover my corrupt PDF file or not? 

To know whether the software will be able to repair your corrupt PDF file or not, please try the demo 

version of the software. Scan your file using Stellar Repair for PDF  and preview the results for your 

satisfaction. 

  

5. Can Stellar Repair for PDF recover my deleted PDF file? 

No, you cannot recover deleted files using Stellar Repair for PDF. 

  

6. Can Stellar Repair for PDF repair corrupt PDF file of any size containing any number of pages? 

Yes, you can repair corrupt PDF files of any size using Stellar Repair for PDF. 
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